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COURSE INTRODUCTION



Before you begin



Completing the exercises
When learning new concepts or skills, there is no substitute for learning by doing.

This course includes exercises that provide practical, hands-on experience to help you apply your new skills
immediately.

The exercises help reinforce the learning objectives of each lesson. They include a scenario that describes a
business problem that needs to be solved and an overview of the tasks you need to perform to complete the
exercise.

To help you complete the exercises, two levels of support are provided:

l Your Assignment — specifies the high level steps you need to perform to solve the business problem provided
in the scenario.

l Detailed Steps — shows the series of steps needed to complete the exercise.

It is our goal that you can complete the exercises using the scenario and the tasks noted in your assignment. Use
the detailed steps to check your work, or as a last resort to complete the exercise.

Exercise environment
The exercise system for this course is available online and accessed through the Open Exercise System link on
each exercise page. Use the credentials provided in each exercise scenario.

Click the Open Exercise System link to log in to your exercise environment. Enter the credentials provided in
the scenario. After you complete an exercise, log out of the exercise environment. Ensure you use the correct
credentials to log in for each exercise.

Note:  The exercise environment provides a pre-built Pega Platform application configured specifically for this
course. This allows you to focus on the key tasks of each exercise without having to complete ancillary tasks.

Exercise guide reference
While individual exercises are included for each lesson online, you may find it useful to download and print out
the complete exercise guide. This is available in the related content section on the right side of this lesson.
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Pega Platform

Exercise: Guided tour of Pega Express
Pega Express showcases staged-based case management, the ability to edit your designs as you build
and run your application. Pega Express also has tools you can use to preview the application on a
desktop, laptop, tablet, or mobile phone.

Using Pega Express, you build applications quickly using any of the interactive tools and features. For a
more guided approach, you can take a tour. Or you can complete the tasks that display in the
Achievements widget of your dashboard. Context-sensitive help and online help are also available to
assist you each step of the way.

A guided tour of Pega Express is available in your training environment.

To take the guided tour, use the Open exercise system link to access your personal training
environment.

The following table provides the login credentials you need to take a guided tour of Pega Express.

Role Operator ID Password
Explorer explorer.sampleapp rules
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Designing a case life cycle

Exercise: Modeling a case life cycle

Scenario
TGB wants to extend its human resources (HR) application to process onboarding cases for new
employees. These cases guide new employees and HR business partners through the onboarding
process. The process for onboarding new employees includes:

l Identifying the corporate location (home office) from which the new employee will be based

l Selecting the new employee's orientation plan

l Preparing and emailing a welcome packet to the new employee

l Requesting that the Facilities department prepare a cubicle or office

l Allowing the employee to sign up for benefits, including company-sponsored health care

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Model the case life cycle for the onboarding process.

Detailed steps
Follow these steps to model the case life cycle of the onboarding process.

Building the Pre-Arrival Setup stage
1. In Pega Express, select the Cases Explorer, and then click New to create a new case type.

2. In the Case type name field, enter Onboarding, and then click Next. A new case type record
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displays in the work area.

Tip: Click the X in the guided tour dialog to close the guided tour.

3. Click the Workflow tab to begin modeling the Onboarding case life cycle.

4. Click Add lifecycle. A case life cycle with one stage displays.

5. In the text field of the first stage, enter Pre-Arrival Setup as the name of the first stage.

6. In the contextual properties panel on the right, ensure that Automatically move to next stage is
selected to advance automatically.

7. Move your mouse over + PROCESS and then click + STEP.

8. Select the Collect information step type.

9. Enter Identify HomeOffice as the name of the step.

10. Enter SendWelcome Packet as the name of the process.

11. Add a second Collect Information step, and enter Select Orientation Plan as the name of the step.
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12. Click + STEP, then selectMore > Utilities to view choices.

13. Select the Send Email utility, and then click Select.

14. Enter SendWelcome Packet as the name of the third step.
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15. Save your changes. The Onboarding case life cycle displays as shown in the following image:

Building the Facilities Setup and Benefits Enrollment stages
1. Click + STAGE to add a second stage to the Onboarding case life cycle.

2. Enter Facilities Setup as the name of the second stage, and ensure that the Automatically move to
next stage option in the contextual properties panel is selected.

3. Add three steps to the default process in the Facilities Setup stage using the information in the
following table:
Step
order

Step type Step name

1 Collect
Information

Select Seating Location

2 Collect
Information

Select Office Equipment

3 Approve/Reject Review Facilities Setup
Note: Notice an alternate stage is added to the case life cycle. You will
add details to this alternate stage later.

4. Enter Request Seating and Equipment as the name of the process.
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5. Save your changes. The Onboarding case life cycle displays as shown in the following image:

6. Add a third stage to the Onboarding case life cycle, enter Benefits Enrollment as the name of the
stage, and select the Resolve the case option in the contextual properties panel.

7. Add a Collect Information step, and enter Select Healthcare Benefits as the name of the step.

8. Save your changes. The Onboarding case life cycle displays as shown in the following image:

Verify your work
Test the Onboarding case to verify the steps added to the case life cycle.

Note: This playback helps demonstrate how a case life cycle model can be executed without any
additional configuration.

1. Click Run to create a new instance of the Onboarding case type. A new Onboarding case is created.

2. The new Onboarding case does not have any data fields defined yet. Click Done to advance the
case to the next step.

3. Notice the case is on the Identify Home Office step in the first stage (Pre-Arrival Setup). This
playback is used only to confirm the case advances from one stage and step to another as defined
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in the case life cycle. You can configure views later. Click No, advance the case to advance the
case to the next step.

4. Confirm the case is on the Select Orientation Plan step in the Pre-Arrival Setup stage. Click No,
advance the case to advance the case to the next step.

5. Confirm the case is on the Select Seating Location step in the Facilities Setup stage. Click No,
advance the case to advance the case to the next step.

Note: The Send Welcome Packet step is not displayed because it is an automated step.

6. Confirm the case is on the Select Office Equipment step in the Facilities Setup stage. Click No,
advance the case to advance the case to the next step.

7. Confirm the case is on the Approval step in the Facilities Setup stage. Click Approve to advance the
case to the next step.

8. Confirm the case is on the Select Healthcare Benefits step in the Benefits Enrollment stage. Click
No, advance the case to advance the case to the next step.

9. Confirm the status of the Onboarding case is set to Resolved-Completed.
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Guiding users through a case life
cycle

Exercise: Guiding users through a workflow

Scenario
The goal for this iteration of the Onboarding case life cycle is to add directional cues and set the
relevant status of the case. These enhancements help new employees, and those involved in the
onboarding case, clearly understand the status of the case and the intent of assignments.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Note: Logging in as author.hrapps displays Pega Express. You will switch to Designer Studio to enter
the instructions and complete this exercise.

Ensure the status and instructions are provided for each step of the Onboarding case. Use the
information in the following table to complete this assignment:

Step Status Instructions
Identify Home Office Open Specify the company office where the new employee will be

based

Select Orientation Plan Open Prepare the new employee orientation plan

Select Seating Location Open Select an office seat for the new employee

Select Office Equipment Open Select office equipment for the new employee

Select Healthcare
Benefits

Open Select your preferred healthcare benefits or waive the coverage

Important: If you want to add punctuation to the end of the instructions, you must encase the
instructions in double quotes. Using punctuation without encasing the text string in double quotes
will result in an execution error at run time.
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Detailed steps
Follow these steps to add user guidance to a case type.

1. Click the double-headed arrow in the lower left corner to switch to Designer Studio to add
instructions for steps.

2. In Designer Studio, click Cases to view a list of available case types.

3. In the Case types panel, select the Onboarding case type.

4. Select the Identify Home Office step.

5. On the General tab of the Contextual Properties panel, set the case status to Open.
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Tip: Place your cursor in the Set case status field, and then press the down arrow on your
keyboard to display a list of available statuses.

6. In the Instructions text field, enter Specify the company office where the new employee will be based as
the text to display.

Important: If you want to use punctuation, encase the text string — including all punctuation — in
double quotes.

7. Repeat steps 3 through 5 to set the case status and specify instructions for each of the remaining
steps using the information in the following table:

Note: Complete as many of these additional steps as you believe are necessary for mastering this
task.

Step Status Instructions
Select Orientation Plan Open Prepare the new employee orientation plan
Select Seating Location Open Select office seating for the new employee
Select Office Equipment Open Select office equipment for the new employee
Select Healthcare Benefits Open Select your preferred healthcare benefits or waive coverage

8. Click Save to save your changes.

Verify your work
Create a new Onboarding case to test your changes.

1. Open the Onboarding case type, and then click Run to create a new instance of the Onboarding
case type.

2. On the New: Onboarding screen, click Done.

The instructions and status are displayed on the Identify Home Office screen.
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Continue advancing through the Onboarding case to verify the case status and instructions for each of
the steps you completed in the exercise.
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Defining user views

Exercise: Configuring a standard user view

Scenario
The initial case life cycle design for the Onboarding case type is complete. You can now configure user
views to collect and display the information required to complete the onboarding of a new employee.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Configure the default Create user view with a field group named Employee, that contains the fields as
shown in the following table:

Label Type Options
Start Date Date only Optional

Department Text (single line) Optional

Manager Text (single line) Optional

Contractor Boolean Optional

First Name Text (single line) Optional

Last Name Text (single line) Optional

Email Address Email Optional

Detailed steps
Follow these steps to configure a standard user view.
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1. In Pega Express, click Cases to view a list of available case types.

2. In the Case types panel, select the Onboarding case type.

3. Click Views to display available user views, and then select the Create view.

4. Click Edit this view to add fields to the user view.

5. In the first empty Label field, enter Employee.

6. Tab to the Type drop-down list and select Field group.

Tip: The Field group option is in the Complex types section at the bottom of the list.
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7. Click Open to add fields to the Employee field group.

8. In the first empty Label field, enter Start Date.

9. Tab to the Type drop-down list and select Date only.

10. Below the field you just entered, click Add field to add another field to the user view.

11. Repeat steps 8 through 10 to add the fields shown in the following table:
Label Type Options
Department Text (single line) Optional
Manager Text (single line) Optional
Contractor Boolean Optional
First Name Text (single line) Optional
Last Name Text (single line) Optional
Email Address Email Optional
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12. Click Submit to save your changes to the user view.

13. In the upper right corner of Pega Express, click Save to save your changes to the Onboarding case
type.

Verify your work
In the upper right corner of Pega Express, click Run to run an instance of the Onboarding case type.

The fields you created are added to the standard Create view.

Exercise: Configuring a custom user view

Scenario
The initial case life cycle design for the Onboarding case type is complete. You can now configure user
views to collect and display the information required to complete the onboarding of a new employee.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules
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Your assignment
Configure user views for the steps in the Onboarding case as shown in the table below:

Step Field Label Field Type Options List choices
Identify Home Office Office Picklist Atlanta

Berlin
Tokyo

Remote employee? Boolean

Select Seating Location Office Text (Single line) Read-only

Location Picklist

Detailed steps

Configure the Identify Home Office user view
1. In Pega Express, click Cases to view a list of available case types.

2. In the Case types panel, select the Onboarding case type.
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3. From the case life cycle view, select the Identify Home Office step.

4. From the Contextual Properties panel, click Configure view to add properties to the form.

5. In the first empty Label field, enter Office.

6. Tab to the Type drop-down list and select Picklist as the field type.

7. To the right of the Options drop-down list, click the Gear icon to open a popup to configure the
field.
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8. In the List choices field, enter Atlanta.

9. Under the field, click +Add choice to add an empty field to the list.

10. In the empty field, enter Berlin.

11. Click +Add choice to add an empty field to the list.

12. In the empty field, enter Tokyo.

13. Click Submit to complete the configuration of the picklist and return to the user view configuration.

14. Below the field you just added, click Add field to add another field to the user view.

15. In the empty Label field, enter Remote employee?

16. From the Type drop-down list, select Boolean as the field type.

17. Click Submit to save your changes to the user view.

18. Click Save to save your changes to the Onboarding case type.

Configure the Select Seating Location user view
Follow the procedure above to configure the Select Seating Location user view.
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1. Add fields to the user view using the data shown in the following table:
Label Type Options
Office Picklist Read-only
Location Picklist Optional

2. Click Submit to save your changes to the user view.

3. In the upper-right corner of Pega Express, click Save to save your changes to the Onboarding case
type.

Verify your work
1. In the upper-right corner of Pega Express, click Run to run an instance of the Onboarding case type.

2. Click Done to advance the case to the Identify Home Office step. The fields you added to the
Identify Home Office user view are displayed.

3. From the Office drop-down list, select Atlanta.

4. Click Submit to advance the case to the next step. Confirm the case is on the Select Orientation Plan
step.
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5. Click No, advance the case to advance the case to the Select Seating Location step. The fields you
added to the Select Seating Location user view are displayed. The Office field displays the value
Atlanta. The Location Picklist is not yet complete.
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Validating case data

Exercise: Validating user entries on forms

Scenario
To avoid processing delays for onboarding and benefits enrollment cases, the Human Resources (HR)
department asks you to ensure that users provide accurate data when processing an onboarding
request. HR wants to ensure that users enter a start date and select a home office. In addition, HR
wants to ensure that the start date for a new hire is entered correctly as a future date.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Validate the start date for a new employee to ensure that users can only enter a future date. To do this:

l Create a validate rule to test the employee's start date (.StartDate).

l Configure the first stage of the workflow to call the validate as a stage entry condition.

Detailed steps

Create a validate rule to test the value of the Start Date property
For an onboarding case, the start date of the employee must be a date in the future. Create a validate
rule to test the value entered by the user. If the date is not in the future, prevent the case from
advancing to the Pre-Arrival Setup stage.

1. Switch to Designer Studio for access to the Validation tab.

2. From the Case Explorer, open the onboarding case.

3. On the Workflow tab, click the Pre-Arrival Setup stage. You will be adding the employee start date
validation at the beginning of this stage.

4. In the contextual properties panel for the Pre-Arrival Setup stage, click the Validation tab to display
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the validation field.

5. In the Set entry validation field, enter StartDateIsFuture to name the validate record and click the
target to the right of the field to display the Create Validate form.

6. In the Label field, ensure StartDateIsFuture is displayed and click Create and open to open the Edit
Validate form.

7. In the Property field, select .Employee.StartDate to specify the property that will be flagged if
validation fails.

8. To the right of the Property field, click the Add link to define the validation condition.

9. In the Select a function field, press the down arrow on the keyboard and select [a datetime] is
in the [past/future] as the validation function.

10. In the field below Select a function, select .Employee.StartDate to test the start date.

11. In the is in the field, ensure Past is selected.
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12. In the Message field, enter Must be a future date.

13. Click Submit to complete the configuration of the validation condition.

14. Click Save to display the completed condition on the form.

15. Navigate back to the workflow and click Save to be sure all your changes are saved.

Require the start date and office fields
By default, start date and office are optional fields. By configuring start date and office as required
fields, you ensure that the user enters a start date and the office location.
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1. From the Cases explorer, click the Onboarding case type and select the Views tab to display the
available views.

2. Click the Create view to display the fields in the create view.

3. Click the Open link next to the Create - Employee options field to view employee properties.

4. In the Start Date row, click the Options drop-down and select Required to make the start date a
required field.

5. Click Submit to close the form.

6. Click the Identify Home Office view to display the fields in this view.

7. In the Office row, click the Options pull-down and select Required to make the office a required
location.

8. Click Submit to close the form.

9. Navigate to the Workflow tab and click Save to save your changes.

Verify your work
Review your changes by creating an onboarding case. Verify that the Collect Employee Information
form requires users to provide a start date that is in the future. Also verify that the Identify Home
Office form requires users to select an office location.

1. From the +Create menu, select New > Onboarding to create a new onboarding case.

2. On the New: Onboarding form, click Done. Verify that you are unable to submit the form until you
provide entries in the required fields.

3. In the Start date field, enter today's date.

4. Click Done. Verify that the Start date field is flagged with a message indicating that the entered
date must be in the future.

5. Correct the error by selecting tomorrow's date.

6. Click Done. The Identify Home Office form is displayed.

7. On the Identify Home Office form, do not select a home office and click Submit. Verify that you are
unable to submit the form.
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8. From the Office list, select one of the values.

9. Click Submit. The application displays Select Orientation Plan form.

Tip: During development, you can update the pyDefault data transform to automatically provide values
for required fields to save time when testing your application. If you do, remember to remove these
initial property values from the pyDefault data transform before your application is released.
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Managing case-processing
dependencies

Exercise: Enforcing a case processing
dependency

Scenario
TGB wants to extend its human resources (HR) application to process healthcare benefits enrollment
cases for new employees as part of the onboarding process. Before an onboarding case can be
completed, the user must complete the benefits enrollment process.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Configure the Onboarding case type to create a benefits enrollment child case during case processing
and suspend processing until the user resolves the benefits enrollment child case.

Detailed steps
Follow these steps to prevent Onboarding cases from resolving until the Benefits Enrollment case
resolves.

1. In Pega Express, from the Cases explorer, select the Onboarding case type.

2. Click the Workflow tab to view the case life cycle of the Onboarding case type.

3. In the Benefits Enrollment stage, click +STEP > More > Utilities > Create Case > Select to create a
new child case in the Benefits Enrollment process.

4. Change the name of the step to Create Benefits Enrollment Case.

5. In the Contextual Properties panel, select Benefits Enrollment to create the case.

6. In the Benefits Enrollment stage, click +STEP > More > Utilities > Wait > Select to add a Wait step
in the Benefits Enrollment process.

7. In the Contextual Properties panel, select All and Benefits Enrollment to establish the
dependency.
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8. Select To be resolved to require that the benefits enrollment case be resolved before the
onboarding case can continue processing.

9. Clear the Users can choose to continue process check box to prevent users from completing the
onboarding case before completing the benefits enrollment case.

10. In the Benefits Enrollment process, hover over the Select Healthcare Benefits step, then click the x to
delete the step from the case life cycle.

11. Click Save to complete the configuration of the Onboarding case type.

Verify your work
Test the Onboarding case to verify the steps added to the case life cycle.

1. Click Run to create a new instance of the Onboarding case type.

2. Advance the Onboarding case until you reach the Benefits Enrollment stage.

3. When you reach the Benefits Enrollment stage, you should see that the Benefits Enrollment is a
child case of Onboarding. It should look similar to the following image:
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Capstone Exercise: Designing a case
life cycle

Capstone Exercise: Designing a case life cycle

Scenario
Acme Better Booking, LLC (ABB) manages an online community marketplace where people can list, find,
and book unique global accommodation experiences. ABB has rolled out their first release of the
ReserveIt application built on Pega Platform. In this release, ABB members can list their properties to
lease or rent for short-term lodging on the ABB website. ABB members can also book a listing via ABB's
website, the mobile app, or with the assistance of a call center representative.

For the second release, ABB wants to add automated guest reviews to the ReserveIt application.

Three days after the check-out date, an automated email notification is sent to the guest inviting them
to provide a review of their stay. The guest must be able to decline the invitation in the email
notification.

The guest review is comprised of three categories: their experience with the booking process, their
interactions with the host, and their experience during their stay (including a review of the location,
property, and accommodations).

The guest can rate each category using a descending scoring scale of 5 (five) to 1 (one) points:

Score Description
5 Excellent

4 Above average

3 Average

2 Below average

1 Poor

The guest may submit comments in their review. The guest may choose to cancel their review at any
time prior to submitting the review. The guest has the ability to review and update their feedback prior
to submission. A confirmation email is sent to the guest after they submit their review and a
notification email is sent to the host after every guest review is submitted.

If the guest completes the review, they receive a voucher for a 10 percent discount on a future ABB
booking.

The following table provides the credentials you need to complete the exercise.
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Role Operator ID Password
Case Designer author.reserveit rules

Approach
Add a new case type to the existing ReserveIt application and define the life cycle of a guest review by
organizing the guest review process into stages and steps.

Tip: Complete the Description for each step to help ensure you have accounted for all of the
requirements.

Configure the user view for the first step to present the user with a yes/no choice to accept the
invitation to provide feedback.

Configure user views for each of the review categories: the booking experience, the host interaction
experience, and the stay experience.

Add a case-wide optional action to enable the guest to cancel their review at any time prior to
completing the review.

Add a Create Case step to the Booking case type. This step should create a stand-alone instance of the
guest review case type and start the guest review case by allowing the guest to select whether to
provide or skip the review.

Test case
The following table provides the credentials you need to complete the test case.

Role Operator ID Password
Guest user.reserveit rules

To test that a Guest Review case is created after the guest completes their stay, log in to the ReserveIt
application using the credentials noted in the table above. Create a booking case, and submit the
initial request. Use the Change stage action to advance the Booking case to the Review stage. Use the
Continue Process to advance the Booking case past the three day wait timer. Confirm a Guest Review
case is created.

Tip: Consider turning off the default create screen that Pega displays by default when creating new
cases. You can achieve this in Pega Express by selecting the desired case type from the Case Type
Explorer and clicking the Settings tab. Then select the Skip 'Create' view when users create a new
case check box.

To test the Guest Review case type, confirm the following behaviors:

l The guest receives an invitation to provide a review of their stay, or can decline to do so.

l The guest can review their experience with the booking process, their interactions with the host,
and their experience during their stay (including a review of the location, property, and
accommodations).

l Each review category provides a rating scale of 5 to 1.

l The guest can add free-form text comments to their review.
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l The guest can choose to cancel the review at any time prior to submitting their review.

l The guest is provided an opportunity to review their feedback prior to submitting the review.

l A confirmation email is sent to the guest after they submit their review.
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The building blocks of a Pega
application

Exercise: Updating inheritance for the
Employee data class

Scenario
When TGB hires a new employee, that employee participates in the onboarding process designed to
integrate the new hire into the company. As part of this process, employees receive the training and
equipment to support their work at TGB.

To reduce development time in the future, the Lead System Architect (LSA) assigned to the project has
identified a data class that contains data elements that you may be able to reuse to describe the
employee.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Update the directed inheritance for the Employee data class to allow developers to reuse data
elements in the Data-Party-Person data class and its parent classes.

Detailed steps
Follow these steps to update the inheritance of the Employee data class and reuse standard Pega
Platform data elements.

1. Log in to the exercise system with Operator ID author.hrapps using password rules.

2. In Pega Express, in the lower-left corner, click the double-headed arrow icon to switch to Designer
Studio.

3. In Designer Studio, open the Data Explorer.

4. In the Data Explorer, hover over the Employee data type to display the Options menu.
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5. From the Options menu for the Employee data type, select View definition to open the class record
for the Employee data type.

6. On the Employee class record, in the Parent class (Directed) field, enter or select Data-Party-
Person to configure the Employee class to inherit data elements and other records from the Data-
Party-Person class and its parent classes.

7. Click Save to complete the configuration of the Employee class record.

Verify your work
1. In Designer Studio, in the lower-left corner, click the double-headed arrow icon to switch to Pega

Express.

2. In Pega Express, click Data > Employee to open the Employee data type.

3. On the Data model tab of the Employee data type, in the upper-right corner of the tab, enable the
Show reusable fields option to display additional fields available from the Data-Party-Person class
through inheritance.
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Note: The inherited fields are indicated by a greyed-out trash can icon. The inherited fields are
defined in a locked ruleset provided as part of the Pega Platform installation, and cannot be
deleted.
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Setting property values automatically

Exercise: Initializing a page type property

Scenario
When you configure user views with field group (page) type properties in Case Designer, Pega Platform
automatically adds a Set action to the Pega-provided pySetFieldDefaults data transform. The
pySetFieldDefaults data transform then initializes the page type property when an instance of the case
type is created. However, you can use a custom data transform if you want the page type properties to
initialize after the instance of the case type is created, and only when certain conditions are met.

In this scenario, you must implement a requirement so the Dependents page list property is initialized
only if the employee selects the Spouse/Partner option as their marital status.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
l Create a field group list named Dependents, based on the Dependents data type that is already
defined in the application. Add the field group list to the Identify Dependents user view for the
Benefits Enrollment case.

l Create a data transform named Initialize Spouse in the Benefits Enrollment case type. Configure the
data transform to set the value of the Relationship property in the first in the first index position of
the Dependents page list to Spouse/Partner when the employee selects Married/Partnered as their
marital status.

l Add the data transform to the Confirm Employee Details connector in the Select Participants
process so that the Initialize Spouse data transform executes only after the employee completes the
Confirm Employee Details assignment.

l Remove the Set action for .Dependents(1).pyLabel equal to " " in the pySetFieldDefaults data
transform so the Dependents page list is initialized only when the Initialize Spouse data transform
executes.
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Detailed steps

Create the Dependents field group list on the Identify Dependents
user view
1. In your exercise system, log in as author.hrapps using password rules.

2. In Pega Express, click Cases > Benefits Enrollment to configure the Benefits Enrollment case type.

3. In the the Benefits Enrollment case type, select the Identify dependents step to open the
contextual properties panel for the step to the right of the case life cycle.

4. In the contextual properties panel, click Configure view to configure the user view for the Identify
dependents step.

5. In the Label field, enter Dependents.

6. From the Type drop-down, select Field group (list).

7. Press the Tab key to exit the Type drop-down. Pega selects the Dependents data type, already
defined in the application, and adds the fields to the user view.

8. Click Submit to complete the configuration of the user view.

9. Click Save to update the Benefits Enrollment case type.

Create a data transform to initialize the Dependents page list if the
employee indicates they have dependents
Configure a data transform to set the value of Relationship in the first row of the Dependents page list
to Spouse/Partner if the employee is married or partnered.

1. In Pega Express, click the double-headed arrow icon in the bottom left corner of the browser
window to switch to Designer Studio.
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2. In the Application Explorer, expand Benefits Enrollment > Data Model.

3. Right-click Data Transform and select +Create. A Create Data Transform form is displayed.

4. In the Label field on the form, enter Initialize Spouse.

5. Click Create and open. The Initialize Spouse data transform record is created and displays for
editing.

6. In the first row of the data transform, from the Action drop-down list, selectWhen. The data
transform record displays a second row with an action of Set.

7. In the first row, in the Target field, enter .MaritalStatus=="Married/Partnered".

8. In the second row, in the Target field, enter or select .Dependents(1).Relationship.

9. In the Source field, enter "Spouse/Partner".

10. Click Save to save your Initialize Spouse data transform.

Add the InitializeSpouse data transform to the Select Participants
process
Configure the Select Participants process to run the Initialize Spouse data transform after a user
completes the Confirm Employee Details assignment.

1. On the Workflow tab of the Benefits Enrollment case type, click the Select Participants process.

2. In the context panel, click Open process. The Select Participants flow rule opens.

3. Double-click the connector labeled Confirm Employee Information. The Connector properties
panel opens.

4. In the Connector properties panel, under Set properties, select Apply Data Transform. The Data
transform field is displayed.

5. In the Data transform field, enter or select InitializeSpouse.
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6. Click Submit. A clipboard icon appears on the Confirm Employee Details connector.

7. Click Save to save the flow rule.

8. Click the Benefits Enrollment tab to return to the Case Designer.

9. Click Save to save the case type.

Edit the pySetFieldDefaults data transform and remove the Set
.Dependents(1).pyLabel action
When you create the Dependents field group list, Pega configures the pySetFieldDefaults data transform
with a step to display an empty row in the list of dependents. Update the data transform to remove the
initialization step.

1. Return to the Application Explorer, and expand Benefits Enrollment > Data Model (if not already
expanded).

2. Click pySetFieldDefaults. The Data Transform record is displayed.

3. On the far right side of the .Dependents(1).pyLabel Set action, click the trash can icon to delete the
row.

4. Click Save. Removing this action prevents setting the page by default when a case is created. It will
only be set based on the outcome of your when condition in the Initialize Spouse data transform.
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Verify your work
Create a benefits enrollment case to test that the relationship listed in the first row of the Dependents
list is set to Spouse/Partner if the user selects a marital status of Married/Partnered.

1. From the Case Designer, click Run. The New: Benefits Enrollment form opens.

2. Click Done. The Collect Employee Details form opens.

3. On the Confirm Employee Details form, from the Marital Status field, selectMarried/Partnered.

4. Click Submit to advance to the Identify Dependents form.

5. On the Identify Dependents form, verify that the Dependents list contains one row, and that in this
row, the drop-down list in the Relationship column has been set to Spouse/Partner as shown in the
following image.

Optional: Run another instance of Benefits Enrollment, but this time set the marital status to Single.
Compare the results.
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Setting property values declaratively

Exercise: Automatically updating the total
cost of benefits

Scenario
During the benefits enrollment process, employees select a medical insurance plan, dental insurance
plan, and a vision insurance plan offered by the company. To make affordable choices, employees
need to know the combined cost of their selections. To help employees select affordable options, HR
wants benefits enrollment cases to calculate the total insurance cost and display the total during each
step of the coverage selection process.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
To calculate the total cost of health insurance, another system architect configured the following for
you:

l A data type for each type of coverage. These data types contain properties to describe insurance
plans, including a property to store the cost paid by the employee for coverage (.PlanCost).

l A page property for each benefit type to record the employee cost for each insurance plan.
Page property Benefit type
MedicalPlan Medical Plan
DentalPlan Dental Plan
VisionPlan Vision Plan

Now you will create and calculate the total cost property and add it to each of the coverage selection
forms and the Review Selections form:

l Create a property named "Total benefit cost" to store currency data.

l Configure the expression for the Total benefit cost property to calculate the total benefit cost as the
sum of the employee cost (.PlanCost) for each plan.
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l Add the Total benefit cost property to the following four assignments in the Benefits Enrollment
case life cycle.

Select Medical plan

Select Dental plan

Select Vision plan

Review selections

Detailed steps

Create the Total benefit cost property for benefit enrollment cases
Create a property to store the total cost of benefits selected by the user.

1. In your exercise system, log in as author.hrapps.

2. In the Cases Explorer, select the Benefits Enrollment case type.

3. On the Data model tab, click Add field. A new row is added to the list of properties.

4. Under Name, in the empty field, enter Total benefit cost.

5. Under Type, in the empty field, from the drop-down list select Currency.

6. Click the gear to define Total benefit cost.

7. Check the box to specify that Total benefit cost is a calculated field.

8. From the Function pull-down, select Custom to specify the calculation.
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9. Click in the blank field, and enter or select .MedicalPlan.

10. After .MedicalPlan.PlanCost, enter <space>+<space> and select the next plan: .DentalPlan.PlanCost.

11. After .DentalPlan.PlanCost, enter <space>+<space> and select the last plan: .VisionPlan.PlanCost.

12. Click Submit to submit your calculated field.

13. Click Save to create the Total benefit cost property for the Benefits Enrollment case type.

Add the Total benefit cost property to each of the insurance selection
forms and the Review Selections form
Add the total benefit cost to the Select Medical Coverage, Select Dental Coverage, Select Vision
Coverage, and Review Selections forms. This field displays the total cost of the benefits selected by the
user on each form.
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1. On the Benefits Enrollment case type, click the Workflow tab to return to the case life cycle.

2. In the Insurance selection stage, select the Select Medical plan step.

3. In the context panel for the step, click Configure view. The View Configuration dialog is displayed.

4. On the Fields tab, in the leftmost field, enter or select Total benefit cost.

5. Press Tab to exit the field. The contents of the form updates to reflect the property details.

6. Click Submit to close the View Configuration dialog.

7. Repeat steps 3-7 for the remaining two insurance selection forms and for the Review selections
form. The Review selections form includes all three plans and the Total benefit cost.

8. Set the Options for the three insurance plans to Read-only on the Review selections form before
clicking Submit.

9. Click Save to commit your changes to the Benefits Enrollment case type.

Verify your work
Create a benefits enrollment case to test your configuration.

1. On the Case Designer header, click Run to create a case.

2. Advance the case to the Select Medical plan screen.
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3. Click in the Plan Name field, press down arrow, and click on a plan to select a Medical plan from the
three choices presented.

Note: The Plan Name field can be converted to a drop-down menu. Plan Cost can be displayed in
currency format. These issues are not the focus of this exercise.

4. Click Submit to advance the case to the next benefit plan.

Note: The Total benefit cost increases each time a plan is submitted.

5. Repeat steps 3 and 4 for the Dental and Vision plans.
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6. On the Review Selections view, you see all three plans selected, their associated costs, and the final
Total benefit cost.
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Configuring a work party

Exercise: Creating an employee work party

Scenario
The human resources (HR) department communicates with each new employee through email, fax, and
mail during the onboarding process. To facilitate communication, you must add the employee to the
onboarding case as a work party.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Add the new employee to an onboarding case as a party to the case and populate the work party with
employee information from the Create Employee Info form. To do this:

l Define the Employee work party for the Onboarding case.

l Create a data transform named EmployeeParty to populate the work party with identifying
information.

l Add a process named Create Employee Party to the Onboarding case type as the first process in the
Pre-Arrival Setup stage.

l Configure the Create Employee Record process to call the addWorkObjectParty API activity and add
the Employee work party to the Onboarding case.

Detailed steps

Create the EmployeeParty data transform to copy data to the work
party
Create a work party to represent the employee in an onboarding case.

1. Log in to the exercise system with Operator ID author.hrapps using password rules.

2. In Designer Studio, from the Cases Explorer, select the Onboarding case type.

3. From the Onboarding case type, select the Settings tab to edit the case type.

4. On the left, from the list of settings, select Parties to open the list of parties who work on the
Onboarding case or are associated with it.
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5. On the right, in the Parties section under the Interested party name, click + Add party. The Add
party dialog is displayed.

6. In the Add party dialog, click Type and select Party/Person to designate the appropriate class.
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7. In the Data transform field, enter EmployeeParty.

8. To the right of the Data Transform field, click the crosshair icon to create the EmployeeParty data
transform. The New Record form opens.

9. In the upper-right corner of the New Record form, click Create and open to create the data
transform. The Data Transform rule form displays.

10. On the Definition tab of the rule form, in the first row of the data transform, under Target, enter or
select .pxPartyRole.

11. Under Source, enter "Employee".

12. Click the + icon to create three additional rows.

13. Complete each empty row on the data transform using the values in the following table.

Action Target Source
Set .pyEmail1 pyWorkPage.Employee.EmailAddress
Set .pyFirstName pyWorkPage.Employee.FirstName
Set .pyLastName pyWorkPage.Employee.LastName
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14. Click Save to save the data transform. Note the errors that occur.

Note: These errors occur because the context of the source properties is unknown. To resolve this
issue, add a reference for pyWorkPage on the Pages & Classes tab of the data transform.

15. On the Edit Data Transform rule form, click the Pages & Classes tab to specify the class for the page
pyWorkPage.

16. Under Page name, enter pyWorkPage.

17. Under Class, enter or select TGB-HRApps-Work-Onboarding.

18. To the left of the Pages & Classes tab, return to the Definition tab.
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19. Click Save to save the data transform. Note that the data transform saves with no errors.

Create the Employee party for the Onboarding case
Create the employee party to copy property values from the Onboarding case to the Employee work
party,

1. In Designer Studio, return to the open Onboarding case type tab.

2. In the Parties section, click + Add party.

3. In the Add party dialog, enter the information as indicated in the table below.

Role Type Description Data Transform
Employee Party/Person New hire EmployeeParty
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4. Click OK to close the dialog.

5. Click Save to save the case edits.

Add the addWorkObjectParty activity to the Create Employee Record
process

Add a process named Create Employee Party to the Onboarding case type as the
first process in the Pre-Arrival Setup stage.
1. From the Onboarding case type, select the Workflow tab to edit the case life cycle.

2. On the right side of the Pre-Arrival Setup stage, click the down arrow and select Add process.

3. In the new process field, enter Create Employee Party.

4. Move the Create Employee Party process so that it is the first process in the Pre-arrival stage, above
the Send Welcome Packet process.

5. Click Save to save your process.

Add the API activity addWorkObjectParty to the Create Employee Party process
to create the Employee work party automatically.
1. From the Workflow tab, select the Create Employee party process.

2. On the right, in the Process menu pane, click Open process to open the Create Employee Party flow
form.

3. Select and delete the Collect Employee party assignment that was automatically added to the flow.

Note: The employee information is already on the create view.
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4. Add a Utility shape to the process, and connect the shapes as indicated in the screen shot below.

5. Double-click the Utility shape to open the Properties panel.

6. In the Utility field, enter Create EmployeeWork Party.

7. In the Rule field, enter addWorkObjectParty.

8. Press the Tab key to add the activity parameters to the Properties panel.

9. In the PartyRole field, enter Employee to add the Employee work party to the case.

10. In the PartyClass field, enter Data-Party-Person.
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11. In the PartyModel field, enter EmployeeParty.

12. Click Submit to close the Properties panel.

13. Click Save to save the flow.

Note: Model is an older name for a data transform rule.

Test your changes
Create a new onboarding case to confirm that the Employee work party is created automatically after
the user completes the Collect Employee Info assignment.

1. In Designer Studio, from the + Create menu, select New > Onboarding. The Collect Employee Info
form displays.

2. Complete the Collect Employee Info form.

3. Click Submit to submit the form. The Identify Home Office form displayeddisplays.
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4. In the Participants section, verify that the application created the Employee party.

5. On the bottom, along the Developer toolbar, click Clipboard to open the Clipboard tool.

6. In the Clipboard tool, under User Pages, expand pyWorkPage > pyWorkParty.

7. Select pyWorkParty(Employee) and verify that the information you entered on the Collect
Employee Info form populates the Employee work party.

Note: The Employee work party includes information you did not copy with your data transform. Pega
automatically adds additional information to the work party by using rules defined in the Data-Party
class.
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Exchanging data between cases

Exercise: Passing data to another case

Scenario
To avoid data entry errors, the human resources (HR) department wants to avoid entering employee
information on a Benefits Enrollment case during the onboarding process. The HR manager requests
that the new hire data from the onboarding case automatically copy to the benefits enrollment child
case when the case is created.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Configure the Onboarding case type to automatically copy employee data to the benefits enrollment
child case when creating the benefits enrollment case.

Add fields to the Collect Employee Information form of the Benefits Enrollment case to allow users to
view values for the properties on the Employee page.

Detailed steps

Configure the Onboarding case to copy data to the child case
To configure the Onboarding case type to copy data to the benefits enrollment child case, follow these
steps.

1. In Pega Express, from the navigation panel, click Cases, then click the Onboarding case type. The
case life cycle for the Onboarding case type is displayed.

2. In the case life cycle, select the Create Benefits Enrollment Case step.

3. In the contextual properties panel for the Create Benefits Enrollment case, click the Transfer
information to new case check box to display the Transfer information dialog.
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4. In the Transfer Information dialog, in the Map fields section, select the check box next to Employee
to copy the Employee field group from an onboarding case to a benefits enrollment child case.

5. In the View section, clear the Add mapped fields to 'Onboarding Info' view (in 'Benefits
Enrollment' case type) check box.

6. Click OK. The fields are added to the child case and to the Onboarding Info view.

7. Click Save to commit your changes.

Configure the Collect Employee Information user view to display
properties set through data propagation
Add properties to the Collect Employee Information form to display the data copied from an
onboarding case to a benefits enrollment case by following these steps.

1. From the navigation panel, click Cases, then click the Benefits Enrollment case type. The case life
cycle of the Benefits Enrollment case type is displayed.

2. In the Benefits Enrollment case life cycle, click the Confirm Employee Information step.

3. In the contextual properties panel, click Configure View. The View Configuration dialog opens.

4. In the left panel of the View Configuration dialog, select Fields to display the list of fields defined for
the Employee field group.

5. Position the mouse over Employee, then click the plus icon to add the Employee field group to the
Confirm Employee Information user view.

6. In the first row, click the trash can icon to remove the empty row from the user view.
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7. Click Open to create a new user view for the Employee field group.

Note: If the Confirm Employee Information - Employee user view does not display the full set of
fields, return to the Confirm Employee Information user view (step 6), use the drop-down list to the
left of the Open link to change the user view, re-select Confirm Employee Information - Employee ,
then click Open again.

8. Click Submit to complete the configuration of the user views and dismiss the View Configuration
dialog.

9. Click Save to commit your changes to the Benefits Enrollment case type.

Verify your work
1. From the navigation panel, click Cases, then click the Onboarding case type.

2. In the upper right corner, click Run to execute an instance of the Onboarding case type.

3. Complete the New: Onboarding form.
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4. After you complete the New: Onboarding form, note the contents of the form, then click Done to
advance to the next step.

5. Continue through the steps of the Onboarding case, until you create the Benefits Enrollment child
case.

Note: After you complete an approval step, select the next step from the Action menu.

6. On the Confirm Employee Information step of the Benefits Enrollment case, confirm that the
contents of the fields match your entries on the New: Onboarding form.



64
©2018 Pegasystems



65
©2018 Pegasystems

Caching data with data pages

Exercise: Creating a data page to populate a
list of seating locations

Scenario
During the onboarding process, new employees are assigned an office or cubicle in one of TGB's five
offices. To ensure that users select a valid seating assignment, Human Resources (HR) wants to access
a list of seating locations maintained by the Facilities department. This information should be
presented as a drop-down list, allowing users to select an open seating location in the appropriate
office.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
The Seating Locations data type includes records for both available and unavailable offices and
cubicles in TGB facilities. Use the Filtered Seating Locations report provided in your exercise
environment to populate a data page with only available seating locations in the selected home office.
Then update the Select Seating Location user view to display the open seating locations in a drop-down
list.

Note: This exercise requires use of Designer Studio to configure the data page and user view.

Important: Remember to check out and check in records as needed to complete the exercise.

Detailed steps
To accomplish this task you will:

l Create a data page named D_FilteredSeatingLocations and source the page using the Filtered Seating
Locations report.

l Configure the Location drop-down list on the Select Seating Location user view to use a data page as
a source. Select the seating location property (.ID) on the drop-down list as the value to display and
as the value to set.



66
©2018 Pegasystems

Configure a data page to read data from the appropriate database
table
1. In Designer Studio, in the navigation pane, click Data to open the Data Explorer.

2. In the Data Explorer, right-click the Seating Location data type and select Add data page to create a
new data page to present seating location records.

3. In the Label field, enter Filtered seating locations to name the data page.

4. Click Create and open. The data page rule form is displayed.

5. From the Structure drop-down list, select List to return a list of results.

6. From the Source drop-down list, select Report Definition.

7. In the Name field, enter FilteredSeatingLocations to populate the data page with the results
returned by the FilteredSeatingLocations report.
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8. On the data page, click the Parameters tab to add a parameter to the data page.

9. On the Parameters tab, in the Name field, enter HomeOffice.

10. In the Description field, enter Home office for new employee.

11. Click the Definition tab to continue configuring the data page.

12. On the Definition tab, in the Data sources section, under the Name field, click Parameters to
display the Parameters for FilteredSeatingLocations dialog and specify a value for the parameter
used by the report.

13. In the Value field, enter Param.HomeOffice.

14. Click Submit to close the Parameters for FilteredSeatingLocations dialog.

15. Click Save to save the data page. A warning appears in the rule header.

16. In the rule header, click view to view the warning.

17. In the Data sources section, in the System name field, enter Seating Locations table.

18. Click Save to complete the configuration of the data page. The warning disappears from the rule
header.

Configure the Location drop-down list on the Select Seating Location
form to source data from a data page
1. In the Application Explorer, select Onboarding > User Interface > Section >

SelectSeatingLocation to open the section that defines the Select Seating Location user view.

2. To the right of the Location field, click the gear icon to open the Properties panel.
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3. In the List source section, from the Type drop-down list, select Data Page. When you select Data
Page, additional fields display on the form.

4. In the Data Page field, enter D_FilteredSeatingLocations.

5. In the Value field, enter or select .Office to pass the value of the Office field to the data page as a
parameter.

6. In the Property for value field, enter .ID.
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7. Click Submit to close the properties panel.

8. Click Save to save the Select Seating Locations section.

Verify your work
1. From the Actions menu, select Preview. The Preview window opens.

2. Verify that the Locations drop-down contains a list of open offices.

Note: In the Preview window, the list of open offices is not filtered by home office, since the report
relies on the value of the .Office property. You can enter a value for the Office property— for
example, Atlanta or Berlin— and observe that the available seat list changes.

3. Create a new Onboarding request.

4. On the Identify Home Office form, from the Office drop-down list, select a home office.

5. Advance to the Select Seating Location step.
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6. Verify that the application only returns a list of seating locations for the selected home office.
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Managing reference data

Exercise: Configuring a list of dynamic values

Scenario
The Identify Home Office user view prompts the user to select the home office for a new employee. The
current list is defined as a static list, which makes it hard to update when new offices open. TGB
opened two new offices in London and Vancouver. To better reflect the opening and closing of TGB
offices worldwide, configure the drop-down control to display a dynamic list of offices, rather than a
static list.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Add records to the Office data type for the two new offices.

Update the Identify Home Office section to populate the Office drop-down list using the data page D_
OfficeList, rather than a static list populated from the property definition.

Add records to Pega local storage
Add records to the Office data type for the two new offices.

1. In the Data Explorer, select Office.

2. Click the Records tab to view the existing data associated with the Office data type.

3. Click + Add record to add two new data entries.

ID Name Country
LON London United Kingdom
VAN Vancouver Canada
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4. Click Done to commit your changes to the Office property record.

Configure the dynamic list
Configure the Identify Home Office user view to populate the list of office locations from a data type.

1. In the Application Explorer, select Onboarding > User Interface > Section > IdentifyHomeOffice
to open the section that defines the Identify Home Office user view.

2. To the right of the Office field, click the gear icon to display the Cell properties panel.

3. In the field to the right of the Include placeholder check box, enter "Select a home office...".

4. Under List Source, from the Type list, select Data Page.

5. In the Data page field, enter or select D_OfficeList.

6. In the Property for value field, enter or select .Name.

7. Click Submit to complete your configuration of the Office drop-down list and dismiss the Cell
Properties panel.

8. Click Save to commit your changes to the Identify Home Office user view.
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Verify your work
1. Create a new Onboarding case.

2. Click Done to complete the New: Onboarding form and advance to the Identify Home Office form.

3. Click the Office drop-down list and confirm that the list includes two new entries: London and
Vancouver.
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Capstone Exercise: Modeling case
data

Capstone Exercise: Modeling case data

Scenario
The product manager at ReserveIt wants to improve the quality of feedback provided by guests. The
product manager requests that you add two steps to the booking feedback process to allow guests to
identify the parts of the booking process they liked best and least.

In addition, the product manager wants to support a future request to display an average of review
scores on a listing. To satisfy this request, the product manager asks that you convert the text values
provided by the rating picklists to integer values.

Approach
Create a data type containing a list of areas of the booking process and ID codes to sort the areas. Add
the areas and ID codes in the following table to the data type.

Area (text) ID number (integer)
Amount of detail in listings 1

Ease of booking process 2

Speed of responses to inquiries 3

Variety of listings 4

Other... 100

Note: The ID number field can be used to sort the list of areas to ensure that Other... is displayed last
in the list. The actual sorting takes place in Designer Studio and is not covered in this exercise. Sorting
is a challenge task accomplished by configuring the report used to populate the list.

Configure a user view in the Assess Booking process to allow guests to identify the part of the booking
process they liked the most. Configure a second user view to allow guests to identify the part of the
booking process they liked the least. To each user view, add a drop-down list that displays the areas
from the data type you created. Prompt users by displaying a placeholder for each list. Following each
list, add a text field to allow guests to identify an unlisted area if the guest selects Other... from the list.

Tip: Create a data reference on each user view to populate the list of areas for the guests.

Create three integer properties to store the converted ratings. Configure a data transform in Designer
Studio to set the value of each integer property by converting the text values for the booking, host
interaction, and stay ratings provided by the user. Use the function @toInt to convert the rating value
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when users provide feedback on a booking, host, or stay. If the user does not provide a rating, then skip
the conversion. For example, if the user chooses to rate only the booking process, then the data
transform skips the conversion of the host rating and stay rating.

Test cases
To test your application, run the Guest Review case in Pega Express. The following table provides the
credentials you need to complete the test case.

Role Operator ID Password
Case Designer author.reserveit rules

Confirm the following behavior when reviewing the booking process.

l Users can select their favorite area of the booking process

l Users can add an area if their choice is not available from the list of favorite areas

l Users can select their least favorite area of the booking process

l Users can add an area if their choice is not available from the list of least favorite areas

Confirm that the application converts the ratings provided by users into integer values after users
review their feedback. Use the Clipboard tool to confirm that the data transform provides integer
equivalents for each rating provided by guests.

Detailed steps
A proposed solution for this exercise is available as a download in the Related Content section.
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Configuring a service level agreement
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Exercise: Adding a service level to a case

Scenario
TGB has a business policy of onboarding new employees within 15 business days of formal offer
acceptance.

The Human Resources (HR) department promotes a goal of 10 business days to encourage members to
process cases before the deadline. TGB wants members of the HR department to be able to track the
time remaining for the goal and deadline when processing an onboarding case.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Configure the Onboarding case type with a goal and a deadline.

The following table lists the intervals and urgencies to configure.

Interval Urgency
Goal - 10 business days 10

Deadline - 15 business days 20

Detailed steps
Follow these steps to add a service level to a case.

1. In Pega Express, open the Onboarding case type.

2. Click Settings to edit the settings for the case type.
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3. Click Goal & deadline to edit the goal and deadline settings.

4. Select the Consider goal and deadline check box.

5. In the Days field for the Goal, enter 10. This is the preferred time frame to complete the case.

6. In the Increase urgency by field, confirm urgency increase is set to 10.

7. In the Days field for the Deadline, enter 15. This is the maximum time frame to complete the case.
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8. In the Increase urgency by field, enter 20.

9. In the upper right corner of the case, click Save to save your changes to the goal and deadline
settings.

Verify your work
1. In the upper right corner of the case, click Run to execute the Onboarding case type.

2. In the Employee information view, click Done to advance to the identify Home Office user view.

3. Verify that the Goal, Deadline, and Urgency are correct.

Note: At run time, the countdown for both the goal and the deadline begins immediately,
displaying only the number of days remaining. In this example, the remaining Goal time is 9 days
and the Deadline is 14 days.
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Exercise: Configuring a service level
agreement rule

Scenario
As part of the onboarding process, managers must identify an orientation plan for each new employee.
During the onboarding process, HR selects one or more orientation courses for the employee. To
ensure that HR can enroll the new employee in the selected courses, the orientation plan for an
employee must be completed within two days, and preferably within one day. If the HR partner
assigned to the onboarding case fails to complete the assignment within two days, a reminder email is
sent to the HR partner every day until the assignment is completed.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
System Architect author.hrapps rules

Your assignment
Add a service level agreement to the Select Orientation Plan assignment of the Onboarding case type.
Configure the service level agreement to remind HR partners to select orientation courses for the
employee in a timely manner by configuring:

l A goal interval of one day.

l A deadline of two days.

l A repeating action for late assignments to send a reminder email to the HR partner.

Detailed steps
Configure a service level agreement for the Select Orientation Plan assignment. For this service level
agreement:

l Create the service level agreement for the Select Orientation Plan.

l Configure intervals and urgency adjustments for the service level agreement.

l Verify your work.
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Create the service level agreement for the Select Orientation Plan
1. In Designer Studio, open the Onboarding case type.

2. In the Pre-Arrival Setup stage, click the Select Orientation Plan step. The properties panel for the
step opens to the right of the case life cycle.

3. In the properties panel, click the Goal & deadline tab.

4. Select the Consider goal and deadline check box. The properties panel updates to display goal
and deadline configuration options.

5. From the Service level agreement list, select Use existing. An empty field displays below the list.

6. In the empty field, enter SelectOrientationPlan.
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7. Click the crosshair icon to the right of the field to open the New Record form as shown in the
following image.

8. Click Create and open to create and open the Service Level Agreement rule form.
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Configure intervals and urgency adjustments for the service level
agreement
1. In the Inital Urgency field, enter 20.

2. In the Service level definitions section, confirm that the Calculate service levels list is set to
Interval from when assignment is ready.

3. In the Goal section, under Days, enter 1.

4. Under Amount to increase urgency, enter 10.

5. In the Deadline section, under Days enter 2.
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6. Under Amount to increase urgency, enter 10.

7. In the Passed Deadline section, clear the contents of the Limit passed deadline events to field.

8. Under Days, enter 1.

9. Under Amount to increase urgency, enter 10.

10. Under Actions, click Select Action. The Perform Action list is displayed for the Passed Deadline
interval.

11. From the Perform Action list, select Notify Assignee.

12. Click Save to save the rule.

13. Click the Onboarding tab. Designer Studio returns to the workflow for the Onboarding case.

14. Click Save to save the rule in the case type.

Verify your work
1. In the Onboarding case type workflow, in the upper right corner, click Run to execute the

Onboarding case type.

2. In the Employee user view, click Done. The onboarding case advances to the Identify Home Office
form.
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3. Click Submit. The onboarding case advances to the Select Orientation Plan form. The time
remaining in the goal interval is displayed on a green background.

Note: This case type also has a service level agreement at the case level. The time remaining for
the entire case displays under Case details.
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Configuring and sending
correspondence
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Exercise: Sending a welcome email to new
employees

Scenario
As part of the onboarding process, TGB sends each new employee a welcome email. This email
contains the start date, manager, and home office for the employee. The email also provides
information about paperwork that the employee must bring on the first day.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Create the welcome email to send to new employees during the onboarding process.

To accomplish this task, perform the following in the Send Welcome Packet step in the Onboarding
case life cycle.

l Create the email text and the properties.

l Configure the email routing.

Note: Your exercise environment is not configured to send email correspondence. During this
exercise, you may notice that the attached email indicates an exception error. This exception results
from the application being unable to send the email in the exercise environment. You can ignore this
error.

Detailed steps

Configure the Onboarding case type to send the welcome email
Configure the Onboarding case type to send the welcome email to the employee at the Send Welcome
Packet step.

1. In Pega Express, click Onboarding to open the Onboarding case type.

2. On the Workflow tab in the Send Welcome Packet flow, select the Send Welcome Packet step. The
properties panel for the Send Email utility shape opens to the right of the case life cycle.
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3. In the Subject field, enter Welcome.

4. Under Message, select Click to edit message. The compose message dialog box displays the
Correspondence rule form editor.

Create the contents of the Welcome email
Enter the contents of the email on the correspondence rule form.

1. In the Correspondence rule form editor, enter the following text:

Dear FirstName,

Welcome to TGB. As discussed in our previous conversation, your first day at TGB will be StartDate.

On your first day, please arrive at Reception in our Office office no later than 9AM. You will be greeted by
your manager, Manager, who will escort you to your orientation session. You will attend New Hire
Orientation for your first week at TGB.

Please bring two forms of identification, as specified in the attached document, and a completed copy of the
attachedW-2 form.

Welcome to TGB!

Note: FirstName, StartDate, Office, and Manager are placeholders for property references. Enter
these placeholders for now, to indicate where to insert property references in upcoming steps.
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2. In the text of the email, select the text FirstName.

3. On the Editor toolbar, click the Insert Property button to open the Properties dialog.

4. On the properties dialog, select Employee First Name to add the first name of the onboarding
employee to the email.
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5. Repeat steps 1-4 to replace the StartDate, Office, and Manager text with property references
associated with the employee onboarding process.

6. Click Done to dismiss the Compose Message dialog.

7. Click Save to update the Onboarding case type.

Add the recipient information
Continue the task by adding the recipient information.

1. Under Send to, select Field.

2. In the field below the one with Field selected, select Employee email to identify the field with the
recipient's email address.

3. Click Save again to update the Onboarding case type to send the email to the recipient during case
processing.
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Verify your work
1. Create a new Onboarding case.

2. In the New: Onboarding form, enter data in the fields as shown in the following example.

3. From the New Onboarding form, click Done to advance the case to the Identify Home Office form.

4. On the Identify Home Office form, in the Office field, select Berlin.

5. On the Identify Home Office form, click Submit to advance the case to the Select Orientation Plan
form.

6. Click Advance this case. Under Attachments, the email generated by the application is listed.

7. ClickWelcome to open the email attachment.
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8. Verify that the content matches the rule and the data you entered on previous forms is in the case.
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Routing assignments
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Exercise: Routing assignments using business
logic

Scenario
During the onboarding process, the Facilities department must set up a workstation for on-site
employees. To avoid delays in the onboarding process, HR wants to ensure that each Facilities request
is routed to the correct local office of the Facilities department.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Update the Onboarding case life cycle to route the Review Facilities Setup step to the appropriate work
queue, based upon the home office specified for the employee. Use the following list of work queues:

l Facilities_ATL@TGB (Atlanta home office)

l Facilities_BER@TGB (Berlin home office)

l Facilities_TOK@TGB (Tokyo home office)

Detailed steps
Follow these steps to route an assignment using business logic.

1. In Pega Express, click Cases to view a list of available case types.

2. In the Case types panel, select the Onboarding case type. The case type opens in the editor.
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3. In the Request Seating and Equipment process, select + STEP > Collect Information to add a new
assignment to the process.

4. In the text field, enter Review Facilities Setup as the name of the assignment step.

5. In the contextual properties panel on the right, from the Route to drop-down list, select Use
business logic to define the conditions used to route the assignment.

6. Next to the Custom condition field, click the Gear icon to add a custom condition.

7. From the Action drop-down list, select Route to work queue.

8. In the Value text field, enter Facilities_ATL@TGB.

9. From the Field drop-down list, select Office as the field to evaluate.
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10. In the Value text field, enter Atlanta as the value.

11. Click Add condition to add a second condition to the business logic table.

12. Repeat steps 7 through 11 to add business logic conditions for other offices using the information in
the following table.

Note: Add as many of the conditions as you feel are necessary for mastering this task.

Office Work queue to route assignment to
Berlin Facilities_BER@TGB
Tokyo Facilities_TOK@TGB

13. In the otherwise section, from the Action drop-down list, select Route to work queue to define a
default work queue.

Tip: If this form gets too long to scroll through, you can use the Tab key to navigate through the
form.

14. In the Value field, enter Facilities@TGB as the default work queue.

15. Click Submit to save your changes to business logic conditions.

16. Hover your pointer over the Review Facilities Setup Approve/Reject step, and then click the X to delete
the step.

17. Save your changes to the Onboarding case type.
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Verify your work
1. Create a new Onboarding case.

2. Complete the New: Onboarding form.

3. Click Submit. The Identify Home Office form is displayed.

4. In the Office field, enter one of the home office locations: Atlanta, Berlin, or Tokyo.

Note: If you do not enter one of the valid office locations, Pega returns an error on the Facilities
Review form. Remember not to check Remote employee?.

5. Click Submit.

6. Continue to the Facilities Review form.

7. Verify that the Facilities Review assignment was routed to the workbasket that corresponds to the
home office you entered in step 4. You may need to click on the Audit tab to see that the next task
has been assigned to the relevant work queue.
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Delegating business rules
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Exercise: Delegating business rules

Scenario
At TGB, managers assign courses that are appropriate to each new employee. The course list details
change monthly. Currently, the managers submit IT tickets for course changes. The managers prefer to
make the changes themselves.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Business architect author.hrapps rules

Human resources
manager

manager.hrapps rules

Your assignment
Delegate the records for the Courses data type to the HR Business Owners access group.

Test your work by logging on to the case manager portal as a human resources manager. Confirm you
can edit the course list details.

Detailed steps
Follow these steps to delegate the records for the Courses data type.

1. Log in to Pega Platform with the business architect credentials.

2. In the bottom left of Pega Express, click the double arrow to switch to Designer Studio.

3. Select the Data explorer to display the data types.

4. Click Courses to open the Courses data type.

5. From the Actionsmenu, select Delegate.
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6. In the Delegate to access group field, begin typing Ma to select Manager.

7. In the Title field, enter Course listing.
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8. In the Description field, enter Courses offered during new hire orientation.

9. Click Delegate to delegate the Courses data type.

Verify your work
1. Click the operator profile icon, and select Log off to log out of Designer Studio.

2. On the Pega Platform log in screen, log on with the human resources manager credentials.
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3. One the left side of the Case Manager portal, select Configuration to display the available
delegated rule.

4. Select Edit to open the courses rule.

5. Select the line item for any course. The following image shows the selection of course code GEN002.
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6. In the Hours field, enter 4 to change the duration to 4 hours.

7. Click Save to save the change and show the new duration.
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Controlling the flow of a case life
cycle
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Exercise: Configuring a process to skip
execution based on conditions

Scenario
TGB hires remote employees — employees who do not work in one of the five main TGB offices. The
onboarding process for remote employees does not require selecting a seating location or requesting
office equipment such as a desk or telephone. The HR department policies indicate that for these
remote employees, onboarding cases should skip the Request Seating and Equipment process.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Configure the onboarding case type to skip the Request Seating and Equipment Setup process for
remote employees.

Detailed steps
Follow these steps to configure a process to skip execution based on conditions:

1. In Pega Express, click Cases to view a list of available case types.

2. In the Case types panel, select the Onboarding case type. The case type opens in the editor.

3. Select the Request Seating and Equipment process.

Note: Some exercise systems may display the process name as Facilities Setup.
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4. In the Process panel, under Start process, select Custom condition.

5. Next to the Custom condition field, click the gear icon to add a custom condition.

6. From the Field drop-down list, select Remote employee.

7. From the Comparator drop-down, select is false.

Note: This "reverse" logic ensures the Request Seating and Equipment process only runs for
employees that are not remote.

8. Click OK to save your changes to the custom condition.

9. Click Save to save your changes to the Onboarding case type.

Verify your work
1. In the upper-right corner, click Run to execute an instance of the Onboarding case type.

2. Click Done to advance to the Identify Home Office step.

3. Select the check box for the Remote employee option.
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4. Click Submit to advance the case.

5. Confirm the case is on the Select Orientation Plan step in the Pre-Arrival Setup stage. Click No,
advance the case to advance the case to the next step.

6. Confirm the case advances to the Benefits Enrollment stage.

The Request Seating and Equipment process should not have executed because the value of Remote
employee was set to true.

Run another instance of the Onboarding case type, but do not select the Remote employee option. Then,
advance the case to the second stage. The Request Seating and Equipment should execute.



109
©2018 Pegasystems

Circumstancing rules

Exercise: Circumstancing the welcome email
for contract employees

Scenario
TGB sends a welcome email to both full-time and contract employees. Unlike full-time employees,
contractors have a shorter orientation period—one day—and must provide different paperwork on
their first day. You must customize the email sent to contractors to reflect these differences.

The table below provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Customize a version of the welcome email to send to contract employees to mention that orientation
lasts one day and that the employee must provide a completed copy of the Contract Employee
Agreement on their first day of work.

Important: The welcome email is saved as part of the Onboarding case type. Before you customize the
email, copy the text of the email to a correspondence rule named Welcome to use as a base rule.

To do this, create a circumstanced version of the Welcome correspondence rule. For a circumstancing
condition, test whether the value of the Contract employee property (.Employee.Contractor) is true.

Detailed steps

Create the base rule for Welcome correspondence
1. In the Cases Explorer, click Onboarding to open the Onboarding case type.

2. Select the Send Welcome Packet step.

3. In the contextual properties panel, click the message text to open the Compose Message dialog.

4. Copy the message text, then click Done to close the Compose Message dialog.

5. In the contextual properties panel, from the Message drop-down list, select Correspondence to
display the Correspondence template field.

6. In the Correspondence template field, enter Welcome.

7. Click Save to update the Onboarding case to reference the Welcome correspondence record.

8. Click the crosshair icon to open the Create Correspondence form.
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9. On the Create Correspondence form, in the Correspondence type field, select Email.

10. Click Create and open to create the correspondence record.

11. Paste the message into the rich-text field.

12. Click Save to complete the configuration of the Welcome correspondence record.

Create a circumstanced version of the Welcome correspondence rule
1. Click the pull-down menu on the Save as button, and select Specialize by circumstance.

2. On the Specialize Correspondence form, select Property and Date.

3. In the Property field, select or enter .Employee.Contractor.

4. In the Value field, enter true.

5. Click Create and open. The Correspondence rule form opens.
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Define the behavior for the circumstance
1. Update the text of the email to read:

Dear <<.Employee.FirstName>> ,

Welcome to TGB. As discussed in our previous conversation, your first day at TGB will be
<<.Employee.StartDate>> .

On your first day, please arrive at Reception in our <<.Office>> office no later than 9AM. You will be greeted
by your manager, <<.Employee.Manager>> , who will escort you to your orientation session. You will attend
New Hire Orientation for your first day at TGB.

Please bring two forms of identification, as specified in the attached document, and a completed copy of the
attached Contract Employee Agreement.

Welcome to TGB!

2. Click Save to save your circumstanced rule.

3. Click Check in to complete your configuration.

Verify your work
1. From the Create menu, select New > Onboarding to create a new onboarding case.

2. On the Collect Employee Info form, select Contractor, then complete the remaining fields on the
form.

3. Click Done. The case advances to the Identify Home Office form.

4. On the Identify Home Office form, from the Office drop-down list, select Berlin.
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5. Click Submit. The case advances to the Select Orientation Plan form.

6. On the Select Orientation Plan form, click Submit.

7. Open the attached email and verify that the content matches the circumstanced version of the rule.
The attached email should mention that the recipient attends New Hire Orientation for their first
day, and that the recipient should bring a completed copy of the Contract Employee Agreement.

8. Close the onboarding case.
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Capstone Exercise: Automating
business policies

Capstone Exercise: Automating business
policies

Scenario
To ensure that customers provide feedback regarding their stays in a timely manner, ABB has
identified several desired process improvements to encourage timely user responses and resolve
orphaned cases.

Implement the following process improvements specified by ABB:

l To receive the 10 percent voucher, the guest must begin their review within three calendar days
after the Guest Review case is created. Send a reminder email one calendar day after the review is
created to remind the guest of the discount offer. If the guest does not begin the review within
three calendar days, close the case with the status of Resolved-Withdrawn.

l If the guest chooses to provide a review, the Guest Review case advances to the Select Feedback
Areas form. Otherwise, the Guest Review case is moved to the Cancellation stage and withdrawn.

l The guest may select one, two, or all three check boxes to identify those feedback areas they wish to
assess. To ensure that the guest provides feedback about at least one part of the reservation
process, one choice is required. If no choice is selected, display the error message "One area must
be selected."

Permit only those views related to the feedback areas selected to be visible to the guest. Skip views
related to unselected check boxes during processing.

The following table details the feedback areas and their related views.

Feedback area Related view
Booking experience Provide Booking Process Feedback
Host interaction Provide Host interaction Feedback
Stay Provide Stay Feedback

l After the guest submits the review, a confirmation email is sent to the guest containing the
following content.

Dear ABB guest,

Thank you for submitting an assessment of your recent ABB stay.
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Your voucher for 10% off a future ABB property reservation will arrive via email in the next 24 hours. Your
reference # is <insert assessment case ID here>.

Happy travels,

ABB Customer Service Team

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.reserveit rules

Approach
To ensure that guests begin the review within three calendar days after the case is created, create an
SLA for the Accept Review step. Set a goal of one day and send a notification to the customer. Then, set
a deadline of three days and specify the pxChangeStage activity to move the case to the Cancellation
stage, which withdraws the case.

Note: To verify that the SLA works as expected, you can set the goal for five minutes and the deadline
for 10 minutes. These settings are used in the Test Case later in this exercise.

To ensure that guests can choose to skip a review, add business logic to move the case to the
Cancellation stage when the user chooses to skip their review.

To ensure that guests provide feedback for at least one area, create a validation condition for the
Feedback stage. Define the error message and create a when condition that evaluates the three check
boxes.

To ensure only views related to selected feedback areas are visible to the guest, configure business
logic for each of the Feedback stage processes. Each condition evaluates the Select Feedback Area
check box selections.

To send the confirmation email, first create a field in your case type to capture the email addresses for
the guest. Add the fields to the Accept Review user view. Then, configure the Send Email step in the
Resolve stage.

Note: When you create a Guest Review case from a Booking case, the Guest Review case skips the
Create view. To mimic this behavior when you create a stand-alone Guest Review for testing, you can
disable use of the Create view. To do so, click the Settings tab on the case type, select General, and
click Skip 'Create' view when users create a new case.

Test case
Create a Guest Review case, but do not complete and submit the Accept Review form. On the form,
open the Audit tab. After five minutes have passed, refresh the form. On the Audit tab, a new item
indicates that the Notify Assignee activity has run. After ten minutes have passed, refresh the form
again. Note that the Change Stage activity has run. The case's status is Resolved-Withdrawn.

Create another Guest Review case. In the Accept Review form, indicate that you do not want to provide
feedback. Then, submit the form. The case's status is set to Resolved-Withdrawn.
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Create another Guest Review case. In the Accept Review form, indicate that you will give feedback.
Enter an email address in the field you added to the form. Do not select a Select Feedback Area
check box. Then, submit the form. The error message you specified in your configuration is displayed.

Select a check box and submit the form to view the relevant feedback form. For example, if you elect to
provide feedback on the host interaction, the Provide Host Interaction Feedback form is displayed.

When you resolve the case, the Attachments section on the user form displays an email link. Click the
link to read the message that you configured. The message to the guest contains the case ID.

Note: The correspondence displays an error message indicating the address is not available. This is
expected as you have not configured your application to send email.

Detailed steps
A proposed solution for this exercise is available as a download in the Related Content section.
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Configuring a user form

Exercise: Configuring a user form

Scenario
As part of the onboarding process, a member of the Human Resources (HR) department enrolls a new
employee in one or more orientation courses. These courses provide the employee with information
about company and department processes. The HR department wants to add a form to Onboarding
cases to present the user with a selectable list of courses. The HR department also wants to ensure the
important course information displays on mobile devices.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
l Configure the Select Orientation Plan user view to display a list of courses that users can select to
generate an employee orientation plan.

l Change the courses column order to ensure the important course information displays on mobile
devices.

Detailed steps

Configure the Select Orientation Plan view fields
Create a Courses field group list that references the Courses data type in the Select Orientation Plan
view.

1. Log in to Pega Express as author.hrapps using password rules.

2. In the Cases Explorer, select the Onboarding case type to display the Onboarding case type.
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3. In the Send Welcome Packet process in the Pre-Arrival stage, select the Select Orientation Plan
step to display the contextual properties panel for the step.

4. On the General tab of the contextual properties panel, click Configure view to display the View
configuration window.

5. On the Fields tab of the Select Orientation Plan view window, click in the Label field and enter
Courses.
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6. Press Tab on your keyboard to move the cursor to the Type drop-down list and select Field group
(list). The Select Orientation Plan window updates to display the elements of the field group list.

7. To the right of the Courses drop-down, click the Gear icon to open the Data type panel.

8. In the Data type panel, select the Is this a data reference? check box. Below the check box, the
Select a source drop-down list is displayed.

9. From the Select a source drop-down list, select List Courses to populate the list of courses.

10. Click Submit to complete the configuration of the data reference. Each field in the Courses field
group list displays as read-only.

11. Click Submit to apply the field list to the Select Orientation Plan view.

12. Click Save to save the changes to the Select Orientation Plan view.

Configure the Courses page list to copy a list of records from the data
type
The data reference for the Courses list refers to the reference data defined for the Courses data type.
Configure the Courses page list to copy data from the data page that displays a listing of the courses,
enabling users to customize the list in an Onboarding case.
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1. In the lower-left corner of Pega Express, click the double arrow to switch to Designer Studio.

2. From the App Explorer, expand Onboarding > Data Model to show the available rule types.

3. Expand Data Model > Property to display a list of the configured properties.

4. Under Property, select Courses to display the Edit Property: Courses window.
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5. On the General tab, under Data access, select the radio button to the left of Copy data from a
data page to configure the page list to display the fields from the courses list.

6. Click Save to apply the changes to the Courses rule.

Configure the Courses section
Configure the Courses section to arrange fields in order of importance.

1. In the lower-left corner of Designer Studio, click the double arrow to switch to Pega Express.

2. In the Cases Explorer, select the Onboarding case type to display the Onboarding case type.

3. On the Onboarding heading, select Run to run the case.

4. Move the case to the Select Orientation Plan view.

Note: The way in which you move through the case views depends on the views you created in
previously-completed exercises.

5. Hover your pointer over the pencil icon and select Configure this view to display the Configure
form panel.

6. In the Configure form panel, under A, clickModify this list to display the list of fields.
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7. Change the column order by selecting the column title rows and dragging them to the designated
position. The following image shows the updated column order.

Tip: Reordering the columns in Pega Express automatically updates the column importance.

8. In the Configure form header, click the X to close the configure form.

Note: Leave the case you are viewing open. for the Verify your work tasks.

Configure the Selection check box
Configure the Selection check box.

1. In the lower-left corner of Pega Express, click the double arrow to switch to Designer Studio.

2. From the App Explorer, expand Onboarding > User Interface > Section to display the configured
sections.

3. Under Section, select SelectOrientationPlan_Courses to open the section rule.
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4. Under Table, below the Selected label, select the cell to display the Gear icon.

5. Click the Gear icon to open the Cell Properties dialog for the Selected check box.

6. Click the Presentation tab to display the presentation properties.

7. In the Edit options field, select Auto to enable editing the field in this section.

8. Click the General tab to display the check box properties.

9. In the Checkbox caption field, clear the contents to remove the caption for the check box.

10. Click Submit to apply the change.

11. Click Save to save the changes.

Verify your work
1. Return to Pega Express by clicking the double arrow.

2. In the Select Orientation Plan view, in your unfinished case, confirm that you can click the selection
boxes in the list.

3. To the right of the Pega Express heading, select each layout option in turn to confirm that the
display of the Courses list changes with the available display area.

For example, the mobile phone layout with the default Apple iPhone 6s option displays an Apple
iPhone 6s interface and shows all of the course fields in a scrolling window.
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Exercise: Configuring responsive behavior for
a table layout

Scenario
The HR department wants to improve the application display for users by moving select course details
from the courses list when viewing the list on a mobile device.

The following table provides the credentials you need to complete the exercise.
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Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
In the existing Courses section, set the importance for the ID, Hours, and Description fields to Other
so they are hidden on devices with smaller screens.

Detailed steps

Change field importance settings
Follow these steps to configure the importance settings for the ID, Hours, and Description fields.

Note: Disregard step 1 if you are logged in to the exercise environment. Disregard step 2 if you are in
Designer Studio.

1. Log in to Pega Express as author.hrapps using password rules.

2. In the lower-left corner of Pega Express, click the double arrow to switch to Designer Studio.

3. From the App Explorer, under Onboarding, select the arrow to the left of User Interface to display
the Section heading.

4. Click the arrow to the left of Section to display the section list.

5. From the Section list, select SelectOrientationPlan_Courses to open the section rule.

6. Under Table, click the small circle above ID to select the ID column and display the gear icon for the
column.

7. Click the Gear icon to open the Column Properties dialog box.

8. In the Importance field, select Other.

9. Click Submit to apply your change.
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10. Repeat steps 6 through 9 for the Description and Hours fields.

11. Click Save to save your work.

Verify your work
1. Return to Pega Express by clicking the double arrow.

2. On the Dashboard, select an unfinished case that is on the Select Orientation Plan step.

3. Optional: create a new Onboarding case and advance it to Select Orientation Plan.

4. To the right of the Pega Express heading, select each layout option in turn to confirm that the fields
display according to their importance, as listed in the following table.

Field Importance
Title primary
ID other
Description other
Hours other
Department secondary
Selected secondary
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For example, selecting either the tablet or mobile phone layouts displays the Title, Department and
Selected columns. The tablet layout can accommodate all the existing course rows on one screen.

The mobile phone layout displays the rows in a scrolling window.
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Creating dynamic content in user
views

Exercise: Adding dynamic behavior to a user
view

Scenario
The Human Resources (HR) department has identified an improvement to selecting the orientation
plan for a new employee. HR wants to allow users to quickly clear all of their selections in the list.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Configure the Select Orientation Plan user view to display a button in the list header to allow the user
to clear their selections.

l Create a data transform to set the value (.Selected) to false for each item in the Courses list.

l Configure the button to call the data transform when clicked.

Detailed steps

Configure a data transform to clear all selections in the Courses list
Configure a data transform to set the value of the .Selected property to false for each item in the list.

1. Log in to the exercise system as author.hrapps using password rules.

2. Switch to Designer Studio.

3. In the App Explorer, right-click Onboarding and select Create > Data Model > Data Transform to
open the Create Data Transform form.

4. On the Create data transform form, in the Label field, enter Clear course selections.

5. Click Create and open to configure the data transform behavior.

6. In the Action column, click the drop-down list and select For Each Page In to configure a step that
acts on each element of a page list. The data transform updates to add a child row below the
current row.
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7. In the row labeled 1, in the Target field, enter or select .Courses to configure the step to act on
elements of the Courses page list.

8. In the row labeled 1.1, in the Target field, enter or select .Selected to set the value of the check box
displayed in each row of the course listing.

9. In the Source field, enter false to set the value of the Selected property and the check box in the
user view.

10. Click Save to complete the configuration of the data transform.

Configure a button to allow users to clear all selections from the
Courses list
Add a button to the user view to run the data transform you configured in the preceding section.

1. From the App Explorer, in the TGB-HRApps-Work-Onboarding class, open User Interface >
Section > SelectOrientationPlan.

2. To the right of the Courses column, click Section to open the embedded section containing the
Courses list.

3. From the Basic menu, click Button and hold down the left mouse button.

4. Drag the cursor to the cell on the far right, in the first row, under the Courses table heading. An
orange line indicates where the button is added to the section.

5. Release the left mouse button. A Gear icon is displayed to the right of the section.

6. Click the Gear icon to open the Cell Properties panel.
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7. On the General tab, enter Clear Selections in the Button caption Text field.

8. Click the Actions tab to display and add an action set.

9. Click Create an action set on the Cell Properties dialog to configure the application behavior when
the user clicks the button.

10. Click Add an event > Click to configure the action set to respond when a user clicks the button.

11. Click Add an action > Display: Refresh to configure the action set to refresh the display of the
section when a user clicks the button.

12. In the Data Transform field, enter or select ClearCourseSelections to run the data transform you
configured in the preceding section.

13. On the Cell Properties dialog, click Submit to update the table.

14. Click Save to apply the change to the section.

Verify your work
Test the Onboarding case to verify the Clear Selections button clears the course selections.

1. Return to Pega Express by clicking the double arrow.

2. Select the Onboarding case from the Cases Explorer to view the case type details.

3. Click Run to create a new instance of the Onboarding case type.

4. Click Done to display the Identify Home Office form.

5. Click Submit to display the Select Orientation Plan form.

6. From the courses list, in the Selected column, select multiple courses by clicking in the check boxes
for each course you are selecting.

7. On the upper-right corner of the list, click Clear Selections to verify that the checks marks are
cleared from the check boxes.
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Exercise: Displaying additional information
with a SmartInfo pop-up

Scenario
The Human Resources (HR) department has identified an improvement to selecting the orientation
plan for a new employee for mobile users. HR wants to provide users on mobile devices with a button
to access additional details for a course.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Configure the behavior of the Select Orientation Plan user view to display content dynamically. Add a
button to the list rows to display the following additional information about each course: course ID,
hours, and description.

l Add a button to the list row, and configure the button with an action set to present the section as a
SmartInfo pop-up when the button is clicked.

l Add a visible when condition to the cell and column header for the button to display only when the
form is viewed on a mobile device. Use the standard when rule pyIsMobile to test whether the form
is displayed on a mobile device.

Important: Test the behavior in Express to mimic a mobile display.

Detailed steps

Configure a section to display additional course details
The responsive behavior of the Select Orientation Plan user view hides the course ID, number of hours,
and description from the user. Create a section to display this missing information.

1. Log in to the exercise system as author.hrapps using password rules.

2. Switch to Designer Studio.

3. In the Designer Studio header, select +Create > User Interface > Section to open the Create
Section form.

4. In the Label field, enter Course detail to name the section rule.

5. Under Additional creation options, select the Create Section using a Design Template check box
to apply a design template to the section rule.

6. In the Apply to field, enter or select TGB-HRApps-Data-Courses to create the section in the data
class for the Courses data type.
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7. In the Create Section header, click Create and open to create the section rule.

8. On the Design tab, click Add new to display a pop-up menu of UI controls that you can add to the
section rule.

9. Click Text Area to add a Text area control to the Course detail section.

10. To the right of the Text area control, click the Gear icon to open the Cell Properties panel for the
control.

11. In the Cell Properties dialog, in the Property field, enter or select Description to configure the field
to display the value of the .Description property.

12. On the Presentation tab, from the Edit options drop-down list, select Read-only (Always) to display
the control as read-only content.

13. In the Cell Properties panel, click Submit to complete the configuration of the control and return to
the Design tab of the section rule.

Configure a heading to display the course ID and duration
Add a heading to the Course Detail section to display the course ID and duration.

1. On the Design tab, click Add new to display a pop-up menu of UI controls that you can add to the
section rule.

2. In the pop-up menu, click the Advanced tab and select Embedded section to embed a second
section in the section rule. The Section Include Modal dialog is displayed.

3. In the Section Include Modal dialog, in the empty field in the row labeled Section, enter
DetailHeader.

4. To the right of the field, click the Crosshair icon to display the Create Section form.
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5. Select the Create Section using a Design Template check box to apply a design template to the
section rule.

6. Click Create and open to create the DetailHeader section rule.

7. In the DetailHeader section, click Add new to display the pop-up menu of UI controls.

8. On the Basic tab, select Text Input to dismiss the pop-up and add a Text input control to the
section.

9. To the right of the Text input control, click the Gear icon to open the Cell Properties panel for the
control.

10. In the Cell Properties dialog, in the Property field, enter or select ID to configure the field to display
the value of the .ID property.

11. In the Cell Properties panel, click Submit to complete the configuration of the ID field and return to
the Design tab of the section rule.

12. On the Design tab, click Add new.

13. Repeat steps 8-11, but enter or select Hours to configure the field to display the value of the
.Hours property.

Apply a two-column template to the header section
Configure the DetailHeader section to display content in two columns.

1. On the Design tab, click Change and select 2 Column to apply the two-column design template. A
second layout labeled B is added to the section.

2. Click the selection handle for the Hours control and drag the control to the layout labeled B.

3. Click Save to complete the configuration of the DetailHeader section.

4. Click the New tab to return to the Course detail section.

5. In the Section Include Modal dialog, click Submit to embed the DetailHeader section in the Course
detail section.
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Note: If clicking Submit returns an error, click Cancel to dismiss the dialog, then reattempt
embedding the DetailHeader section.

Complete the configuration of the Coursedetails section
Arrange the DetailHeader section above the course description. Configure the DetailHeader section to
display as read-only content.

1. Click the selection handle and drag the DetailHeader section control above the Description text
area control.

2. To the right of the Section control, click the Gear icon to open the Cell Properties panel for the
control.

3. On the Presentation tab, from the Edit options drop-down list, select Read-only (Always) to display
the section as read-only content.

4. In the Cell Properties panel, click Submit to complete the configuration of the control and return to
the Design tab of the section rule.

5. Click Save to complete the configuration of the Course detail section rule.

Configure a button to enable mobile users to access additional course
details
Add a button to the course listing to display the Course detail section when the user displays the course
listing on a mobile device.

1. Open the SelectOrientationPlan_Courses section.

2. Right-click the Selected column and select Insert Column > Right to add a column to the table to
the right of the check box.

3. From the Basic menu, click Button and hold down the left mouse button.

4. Drag the cursor to the cell in the second row, on the far right of the Selected heading. An orange line
indicates where the button is added to the section.
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5. Release the left mouse button. A Gear icon is displayed to the right of the section.

6. Click the Gear icon to open the Cell Properties panel.

7. On the General tab, enter More Information in the Button caption Text field to name the button.

8. In the Visibility field, select Condition (when rule) from the drop-down menu to set a when condition.

9. To the right of the Visibility field, enter pyIsMobile to set up the button for mobile device display
only.

10. Click Actions > Create an action set.

11. Click Add an event > Click.

12. Click Add an action > All Actions > Show SmartInfo to create the action associated with the
button.

13. In the Section field, enter or select CourseDetail to identify the section the action applies to.
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14. Deselect the Auto-dismiss on hover away check box to provide users with a Close icon to dismiss
the pop-up.

15. Click Submit to update the table.

16. In the SelectOrientationPlan_Courses section, delete the Button heading.

17. Click Save to complete the configuration of the Select Orientation Plan user view.

Verify your work
Test the Onboarding case to verify the More Information button appears for mobile devices only and
provides the additional omitted information.

1. Return to Pega Express by clicking the double arrow.

2. From the Cases Explorer, click Run to create a new instance of the Onboarding case type.

3. Click Done. The Identify Home Office form displays.

4. Click Submit. The Select Orientation Plan form displays.

5. Click the Tablet icon and select Apple iPad from the drop-down to see the responsive behavior
change for a mobile device.

Note: Ensure you remain in landscape mode for the best view of the More Information buttons.

6. Click any one of the More Information buttons to verify the additional information for course ID,
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hours, and description is displayed.
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Capstone Exercise: Designing user
views

Capstone Exercise: Designing a user interface

Scenario
The product manager for ReserveIt wants to improve the feedback provided by guests. The manager
requests that you make two updates to the feedback user forms.

First, when entering booking feedback, guests select an area from the Area drop-down list in the
Identify Favorite Area and Least Favorite Area user forms. Currently, a text field allows users to enter
area information if the area is not on the list. Guests who select a listed area should not be able to
enter information. Therefore, guests should see the text field only when they select Other... in the list.

Second, when entering stay feedback in the Provide Stay Feedback form, guests should be able to
review the information the guests entered when they created the booking request. To avoid clutter on
the user form, guests should have the option to show or hide the information.

Your assignment is to add both enhancements to the existing feedback user views.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.reserveit rules

Approach

Make the Other Favorite Area and Other Least Favorite Area fields
dynamic
Use a visible when condition in the Other Favorite Area and Other Least Favorite Area fields so
that they are displayed only when users select Other... in the Area drop-down list. The fields are
located in the Search for Favorite Area and the Search for Least Favorite sections. To reduce user
distraction, configure the fields so that they do not shift on the form when the fields are displayed.

The embedded sections that contain the Area and ID fields are not relevant to users. Therefore, set
the sections so that they are never visible.

Configure a button that displays the booking details in a SmartInfo
form
Do the following:
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1. Copy the arrival date, departure date, and listing ID from the Booking case.

2. Create a SmartInfo form to display the booking information. Use the following mockup to guide your
design.
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3. Add a button to the Provide Stay Feedback user view to display the booking information. Use the
following mockup to guide your design.

Test case
Create a Booking case. In the New: Booking user form, enter reservation information in all the fields
and book the location. Advance the Booking case so that it instantiates a Guest Review case.

In the Accept Review Request user form, indicate that you want to provide feedback. Submit the form.
In the Select Feedback Areas user form, indicate that you will provide booking feedback and stay
feedback. Submit the form and advance the case to the Identify Favorite Area user form and select
Other... from the Area drop-down list. The Other favorite area field is displayed. Advance to the
Identify Least Favorite Area form. In the Area drop-down list, select Other... to display the Other least
favorite area field. Note that the fields on the form do not shift position. The Area and ID fields
beneath the Area drop-down list are not displayed on either form.

Advance the Guest Review case to the Provide Stay Feedback user form. Select the View Listing button.
This opens a SmartInfo form. The form includes the Arrival date, Departure date,Metro area, Title,
Address, and Summary fields in read-only format.

Detailed steps
A proposed solution for this exercise is available as a download in the Related Content section.
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Creating business reports
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Exercise: Using the Report Editor

Scenario
The HR manager at TGB has requested a report that counts the number of unresolved onboarding
cases created in the past 90 days. This report contains information for each case returned, such as
case status, entered on date, current stage, and total cases.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Create a report containing all of the information the HR manager needs. Include a chart to make it easy
for the HR manager to tell at-a-glance how onboarding cases are progressing.

The report includes the following columns:

l Case status

l Entered on

l Current stage

l Total

Filter the report to display only unresolved cases created in the last 90 days.

Detailed steps

Create the report
Use the following steps to enter the Report Browser and add a Summary or chart report with data from
the Onboarding case type.

1. In Pega Express, click Reports to access the Report Browser.

2. In the Report Browser, click New report to create a new report.

3. In the New Report pane, from the Report on drop-down list select Onboarding to report on data
specific to the Onboarding case type.
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4. From the New Report pane, click Submit to access the Report Editor where you can add columns
and filters to your report.

Update columns
When you enter the Report Editor, the following columns are included for you in this order: Label,
Case ID, Entered on, and Case Status. Use the following steps to move one column and add another
column to create a report that has the columns in this order: Case Status, Entered on, Current stage,
and CNT(Case ID).

1. Click Case ID and select Show Data as > Count to summarize the data in the Case ID column. The
summarized column shifts to the right-most position in the report.

2. Click Case Status > Move left to move the Case Status column to the left of the Entered on
column.

3. Click Label > Remove column to delete the Label column from the report.

4. Click +Column and select Fields > Current stage to add the Current stage column to the report to
the left of the CNT(Case ID) column.

Update report filters
The following steps guide you through removing a filter and adding a new filter to display a report
containing only unresolved cases created in the last 90 days.

1. From Filter by, click X to remove the Updated in Last 7 Days filter.

2. Click +Filter and select Fields > Create Date/Time to display the Add filter dialog.
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3. In the Add filter dialog, click Select values to open the Select values pane.

4. In the Select values pane, from the Value drop-down list, select Last 90 days.

5. Click OK to return to the Add filter dialog.

6. Click Submit complete the filter. Notice that Filter by now has two filters, including Unresolved Case
and Create Date/Time = Last 90 days.

All of the unresolved onboarding cases created within the last 90 days are now displayed.

Add a chart
Use the following steps to create a chart that displays all unresolved cases created in the last 90 days
broken out by the status and current stages.

1. In the Report Editor, click the Add chart button. A clustered column chart is selected by default for
your data.

2. From the Group by drop-down list, select Case Status to group results by case status.

3. Click Then group by to create a second grouping condition.

4. From the Then group by drop-down list, select Current stage to group results by case status within
each clustered column.

5. From the Series drop-down list, select Case ID to count the number of cases in each column.
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Note: The preceding illustration is an example of the configured chart. Your report results depend
upon your configuration.

6. Click Submit to save your chart.

Make your report available
Use the following steps to save your report and make it available to other managers under Open Cases.

1. In the Report Editor, click the Done editing button and the Save report as pane displays.

2. Enter Unresolved onboarding cases created in the last 90 days in the Title field.

3. My Reports is the default category where your report is saved. Select Open Cases to make your
report available to other managers.

4. Click Submit to save your report and make it available in the Report Browser under Open Cases.

5. From the navigation pane , click the Reports icon to return to the Report Browser.

Verify your work
1. In the Report Browser, verify that your report is in the list of reports.

Tip: Click the Report column header twice to list the available reports in descending alphabetical
order.

2. In the Report Browser, click the title of your report to verify it displays in the Case Manager portal.

3. Drill down to the data by clicking on one of the bars in the chart. The data that the bar represents is
displayed in table format.

4. Click the Unresolved onboarding cases created in the last 90 days link to return to the chart.
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5. Click on any of the entries in the table of your report. You can drill down to the data behind each
entry in your report.
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Optimizing report data

Exercise: Reporting on unresolved
onboarding cases

Scenario
The human resources (HR) department wants to ensure that onboarding cases are processed
promptly. To help track open onboarding cases, HR requests a report that lists each unresolved
onboarding case, grouped by the manager responsible for the case. The report must display the case
ID, home office, start date of the new employee, and current stage for each case returned.

Role Operator ID Password
Case Designer author.hrapps rules

Your assignment
Create a report that displays:

l The manager responsible for the onboarding case (.Employee.Manager)

l The case ID (.pyID)

l The home office of the employee (.Office)

l The start date of the employee (.Employee.StartDate)

l The current stage of the onboarding case (.pxCurrentStageLabel)

Add a filter to the report to skip resolved Onboarding cases.

Group the report results by manager.

Optimize properties to resolve any performance warnings identified for the report.

Note: This report includes unoptimized data.

Detailed steps
Important: By default, Pega Express can only report on optimized data. If you need to report on any
unoptimized data, switch to Designer Studio.

1. From the App Explorer, right-click the Onboarding class, then click Create > Reports > Report
Definition to create a new report definition.

2. In the Label field, enter Open onboarding cases bymanager and office as the rule name.
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3. In the Edit Columns section of the report definition rule form, under Column source, select or enter
.Employee.Manager.

4. Click Add column to create four additional columns.

5. Add the following properties to the columns you created in step 3: .pyID, .Office, .Employee.StartDate,
and .pxCurrentStageLabel.

6. In the Edit Filters section, under Column Source, select or enter .pyStatusWork.

7. For the filter you created in the previous step, from the Relationship list, select Does not start
with

8. In the Value field, enter "Resolved".

9. On the Report Viewer tab, enable the Group results option in the Grouping section.

Note: By default, the report only groups results by the first column, which is sufficient for this
exercise. To group by additional columns, edit the upper limit once it appears on screen.

10. Save the report. A message appears on the report, indicating two unreviewed warnings.

Important: Once you save the report, you must check out the rule before attempting any edits.

11. In the report header, click (review/edit) to view the rule warnings. The first warning indicates that
three properties are not optimized, while the second warning indicates that the report filter may
impact report performance.
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12. Under the Informational warning about the report filter, click Add justification. In the field that
appears, enter Report must filter out resolved cases.

13. Click OK. Note that the number of unreviewed warnings decreases to one.

14. In the App Explorer, under Onboarding, expand Data Model > Property> Employee.

15. Right-click the Manager property, then select Optimize for reporting.

16. The Property Optimization tool opens. The first screen indicates the property to optimize, and the
number of cases affected.

17. Click Next. The second screen of the tool confirms the selection.
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18. Click Next to begin the optimization process.

To monitor the optimization process, open the Column Population Jobs Dashboard. The
optimization is complete once the Processed % column reaches 100.

19. Repeat steps 15-18 to optimize the remaining properties mentioned in the rule warning.

20. Return to the report. Save the report and verify that the warning no longer appears.

21. Check in the report so the rule is available to other users.
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Capstone Exercise: Designing business
reports

Capstone Exercise: Designing business
reports

Scenario
The product manager for the ReserveIt app has requested two reports. The first report displays the
listings for which guests have provided feedback, sorted by the ratings provided. The second report
displays the response rate for guest review cases.

Your assignment is to create both reports using the existing ReserveIt application in Designer Studio.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.reserveIt rules

Approach

Create a summary report displaying the breakdown of listings by
ratings
Create a new summary report for the ABB-ReserveIt-Work-GuestReview class named Summary of listings
by rating.

Note: This report uses unoptimized properties. Optimize any properties identified in guardrail
warnings.

Add columns to design and organize how your report is displayed. The report has only three columns,
arranged in this order: Listing ID, Booking rating, and Case ID. Summarize the case ID using the
Count function.

Note: The Case ID is stored using the .pyID property.

Add report filters to display customer feedback on the booking process. Filter the report to display only
when the customer provides booking process feedback, specifies a booking process score, and the
review includes a listing ID. Optimize the data called out on the guardrail warnings.

Add a stacked chart for your data where Case ID is the vertical axis and Booking ID is the horizontal
axis. The column data is Listing ID.

When you finish, add the report to the Case Metrics category in the Report Browser.
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Create a summary report displaying the response rate for guest
reviews
Create a new report for the Guest Review case type named Completion rates for guest reviews. This
report has only two columns: Case ID and Work status. Summarize the Case ID to count the resolved
cases. Add report filters to display customer feedback. Filter the report to display only resolved cases.

Add a pie chart for your data where Case ID is the vertical axis and Case status is the horizontal axis.

When you finish, add the report to the Case Metrics category in the Report Browser.

Test case
Important: Create several guest review cases and provide booking process feedback by using the
Provide booking feedback form to generate data for the Summary of listings by rating report.

Verify your reports against the examples provided in the following screenshots. Although the report
data may differ, the organization of each report should match the examples provided.
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Detailed steps
A proposed solution for this exercise is available as a download in the Related Content section.
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Unit testing application rules

Exercise: Recording test cases for automated
testing

Scenario
You are preparing your application for production. You want to ensure that the Benefits Enrollment
default work urgency value of 10 was not unintentionally updated. Create a test case to verify that the
value has remained the same.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
tester tester.HRAppsTest rules

Your assignment
As the SA on the project, you will create an automated testing rule for the pyDefault data transform,
which sets the pxUrgencyWorkClass value. You create the test case in the HRAppsTest application,
which contains a ruleset for test case rules.

To achieve your goal, you will do the following:

1. Open the HRAppsTest application.

2. Open and run the Benefits Enrollment data transform pyDefault.

3. To the data transform, add a test case rule.

4. Add a condition to the test case rule to test the pxUrgencyWorkClass value.

5. Verify the functionality for both passed and failed test results.

Detailed steps
Complete the following steps to create a test case.

1. Log in to your test system as tester.HRAppsTest using password rules. This opens the HRAppsTest
application.

2. If you are in Express, click the double arrow to switch to Designer Studio.
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3. In the Application Explorer, select Benefits Enrollment > Data Model > Data Transform >
pyDefault.

The pyDefault data transform opens.

4. If the Target in the first row is not set to .pxUrgencyWorkClassset it to .pxUrgencyWorkClass and click
Save.

5. On the data transform record header, click Actions > Run to invoke the data transform.

6. Click Run again to display the results in an XML file. Locate the pxUrgencyWorkClass line item in the
XMP output file and verify the pxUrgencyWorkClass value is 10.

Note: You may need to disable pop-up blockers to see the XMP output panel. The Convert to test
button does not appear until the XMP output displays.
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7. In the XML file header, click Convert to test to create a new Test Case record.

8. On the Test Case Definition tab, select Add properties to open a list of the property values.
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The list of property values is displayed on the left side of the record and Expected results display on
the right.

9. In the list of values, select the plus sign next to pxUrgencyWorkClass. When it is selected, the plus
sign turns into a green checkmark.

The property and value are added to the Expected results section.

10. Click Done to confirm your selection and close the section.

11. Click Save to open the Details pop-up dialog.
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12. In the Label field, enter a description for the test.

13. Click Submit to close the dialog and create your test case.

Verify your work
Do the following to verify that a match between the test case and pxUrgencyWorkClass values produces
a passed result:

1. Navigate to the Test cases landing page by selecting Designer Studio > Application > Automated
Testing > Test Cases.

2. On the Test cases landing page, in the Test case name column, select the check box next to Test
Work Urgency and click Run.
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In the Result column on the right side of the landing page, a green Passed button is displayed. This
indicates that the pxUrgencyWorkClass value and the value in the test case are the same.

Test for a failed result
Do the following to test whether a mismatch between the test case expected value and
pxUrgencyWorkClass value produces a failed result. In this test, update the expected value to 20. The
pxUrgencyWorkClass value is still 10.

1. In the Result column, click Passed to display the test result.

2. On the Test result header, click Open Test to open the test case record.

3. In the Expected results section in the test case record, update the pxUrgencyWorkClass Value to 20.

4. In the upper right corner, click Check out, Save, Check in.

5. Enter Change value in the Check-in comments, and click Check in to save the updated value.

6. Return to the Test cases landing page by clicking the Application: Automated Testing tab.

7. Click Run to run your test case again. The Result column now displays a Failed button.
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8. Click Failed to open the test result. The test failed because the expected value in the test case and
the pxUrgencyWorkClass actual value do not match as shown in the following image.



SOLUTION BUILD
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Solution build

SAE Solution Build

Use your new knowledge to build a case type
You should now be able to design and configure a case type based on the content in this course. The
SAE Solution Build provides you with an opportunity to practice the skills you learned in this course.
For the SAE Solution Build, you complete the following exercise to configure a case type to process
requests for roadside assistance from claimants with disabled vehicles. The scenario and approach in
the following sections detail the application requirements.

Everything you need to know to build this application is within the course. As you build your
application, remember to save often and to test the application periodically using the provided test
cases. You should review these test cases before you begin. After you complete the solution build,
verify your configuration against the proposed solution. The proposed solution for this exercise is
available as a download in the Related Content section.

Scenario
Indemnity Insurance Company is adding a roadside assistance coverage option to their auto insurance
portfolio through a new business subsidiary named Go-Go Roadside Assist. Roadside assistance
coverage helps drivers when their vehicle breaks down. Coverage includes battery service, flat tire
service, fuel delivery, and lockout service. During roadside assistance, a service professional performs
minor mechanical repairs to enable the car to function again.

Indemnity Insurance Company will configure a Pega application to make the process of obtaining
service accessible to insured drivers while on the road. Claimants may request roadside assistance
using a website, a mobile application, or calling a customer service representative. Claimants with Gold
membership are not invoiced for the service. Claimants with Standard memberships are invoiced.

When the application starts, display the Roadside Assistance Landing page. Claimants can select an
appropriate service request from the landing page. A request for roadside assistance is divided into
four stages: Notification, Setup, Service, and Wrap-up.

l In the Notification stage, claimants create an assistance request by entering the service issue,
personal information and membership type, the service location, and a description of the vehicle. If
claimants have a standard membership, they must also provide credit card details for invoicing.
Claimants can update the information at any point in the stage.

l In the Setup stage, a representative from Go-Go Roadside Assist reviews the submitted information
to verify the claimant making the request has coverage. If approved, the claimant selects the service
provider: AAA, Acme, or Tow Mater. If rejected, the request is canceled and resolved. The application
emails a rejection notification to the claimant that reads, "We are sorry to inform you that your
service request for <service type> is not covered." It is expected that a representative will complete
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their assignment within 15 minutes. If not completed after 30 minutes, the application notifies the
representative's manager.

l In the Service stage, the application creates a service case so that service providers can review the
request details, specify services that were provided to the claimant, and verify that work has been
completed.

Service providers should see a list of the services and the unit costs of each. Service providers can
enter the quantity of each service. The form should automatically display the total cost of each
service based on the quantity and unit cost, and calculate a total for all the services provided.

When a service case is created, the application emails a notification to the claimant that reads, "We
have dispatched <name of the service provider> to assist you. They should arrive shortly."

Sometimes, claimants may change their vehicle location after the service case was opened.
Therefore, claimants must have the option to update their location while the service case is open.
Updating the location in the assistance request should automatically update the location
information in the service case.

l In the Wrap-up stage, requests from Gold members are resolved automatically. Requests from
Standard members are processed for invoicing. A representative reviews the details of the request
and submits it. The application emails a copy of the invoice that reads, "Your credit card has been
billed for your selected service." The invoice includes the payment information and the grand total
of the services the service providers enter in the service case.

Claimants may cancel their service request at any time. A cancellation resolves the request and emails
a notification to claimants that reads, "Your service request <case ID> has been canceled."

Managers must be provided with the following reports:

l A report that shows the number and work status of requests that have been worked on in the
previous 30 days. Managers should be able to view this information in a bar chart that displays the
number of requests for each day.

l A report, organized by state, a listing of membership types, service providers, service providers, case
counts, and average service costs of assistance request cases.

l A report that shows in a map chart, the average service cost of resolved assistance request cases
opened in the last 90 days, organized by state. Managers should be able to click a state on the map
and see the related information provided in the services by membership type, service type, and
service provider report described previously.
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Your assignment is to build a Pega application that satisfies the Indemnity Insurance Company's
requirements. The following diagram illustrates the overall process the application automates.

The following table provides the credentials you need to complete the exercise.

Role Operator ID Password
Case Designer author.gogoroad rules

Approach

Create an Assistance Request case type and life cycle stages
When you open your exercise system, the application contains a Service case type that processes
service vehicle cases. Create an Assistance Request case type for processing assistance requests.

Configure the Assistance Request case type life cycle with four primary stages: Notification, Setup,
Service, and Wrap-up. Add two alternate stages: Cancel Request and No Coverage.

Notification stage
The Notification stage includes two processes. The first process creates the assistance request. The
second process enables claimants who have Standard memberships to enter payment information.

The stage also includes an optional action that enables claimants to update any information they enter
while working in the stage.

Create request process
In this process, claimants enter the information needed to create a request. Claimants specify the
issue that has disabled the vehicle, enter personal information including the type of membership,
enter the vehicle's location, and enter a description of the vehicle. Because each set of information is
used elsewhere in the life cycle, you will have the users enter the information in four forms.

In the specify issue form, claimants must select one of the following vehicle issues:
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l Locked out

l Flat tire

l Dead battery

l Out of fuel

In the enter claimant information form, claimants must enter the following information:

l First name

l Last name

l Email

l Membership type, which can be either Standard or Gold

After claimants submit this information, create a Customer work party using information provided on
the claimant information form.

In the location form, claimants must enter the following location information:

l Street

l City

l State

Note: Optionally, you can use information that is appropriate for another country. For example, you
can specify provinces if the country is Canada.

When the case reaches the location form, change the status of the case to Pending-Qualification. This
means that a representative needs to review and approve the case after the customer submits their
request.

In the vehicle information form, claimants must enter the following vehicle information:

l Make

l Model

l Year

l Color

When claimants submit the vehicle information, a Gold membership request advances to the Setup
stage for approval. Claimants with a Standard membership must provide payment information before
the request advances to the Setup stage.

Payment information process
Configure business logic so that only Standard membership requests use this process.

Note: This business logic is also used to start the invoicing process in the Wrap-up stage, which you
will configure later in this exercise.

Claimants must enter the following payment information:

l Card type, which can be either Visa or MasterCard

l Card number

l Expiration date
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When a claimant submits this information, the request advances to the Setup stage.

Update information optional action
For this stage, add an optional action that allows claimants to review and update the claimant, location,
vehicle, and payment information they enter in the stage.

Setup stage
The Setup stage includes two processes. The first process enables a representative to verify the
information and either approve or reject the request. The second process enables approved claimants
to select a company to provide assistance.

Verify process
This process contains a step that routes the request to any representative for approval. The
representative reads the claimant, location, and vehicle information and determines whether the
vehicle operator qualifies for coverage. The representative can also enter details about the decision.

If the representative approves the request, it advances to the select provider process. If the request is
denied, the request advances to the No Coverage alternate stage and is resolved as rejected. A
notification email is sent to claimants that contains the message described in the scenario.

Add an SLA for this verification step. Define a goal of 15 minutes and a deadline of 30 minutes and add
a related escalation action that notifies the manager. Accept the default urgency values.

Select provider process
In this process, claimants select one of the following providers:

l Acme

l AAA

l Tow Mater

Route the task of selecting a service provider to the operator who created the case.

When claimants submit the information, the request advances to the Service stage.

Service stage
Note: To save time, the Service case type is already created as part of your exercise system. For this
exercise, configure the Assistance Request case type to automatically create a Service case as a child
case.

The Service stage is entirely automated and includes the service process and the Wait until service
completed process.

The first step in the service process first creates a service child case. You must transfer service type,
location, vehicle, and claimant information from the assistance request case to the service case.

The second step sends an email notification to claimants that contains the message described in the
scenario.
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Your exercise environment is not configured to send email correspondence. During this exercise, you
may notice that the attached email indicates an exception error. This exception results from the
application being unable to send the email in the exercise environment. Ignore this error.

The Wait until service completed process instructs the system to wait until the Service case is resolved
before advancing the Request case to the Wrap-up stage.

Note: When the service providers verify that the service is completed, the Service case is resolved.

While the Assistance Request case is in the Service stage, the claimant may update the location
provided during the Notification stage. For the Service case, configure an optional action to allow the
claimant to update their location and pass the updated location to the Service case.

Service case type updates
The Service Vehicle process in the existing Service case type includes only the Resolve service step. You
must update the Service case type to support your requirements.

Add a first step that allows service providers to review the assistance request information. The
Assistance Request service process automatically populates the values.

Add a second step that enables service providers to select the services and determine the costs. Add a
service data type that includes the columns you want to display in this order: service, unit cost,
quantity, and total cost (calculated). This value should change whenever inputs change.

Define a record for each service using the costs provided in the following table.

Service Unit Cost
Battery charge 40

Battery replacement 150

Gasoline 10

Replacement key 50

Tire repair 25

Tire replacement 100

Tow 1

Unlock 25

Note: When providing gasoline, service providers use the quantity field to indicate the quantity
provided. When providing a tow, service providers use the quantity field to indicate the distance the
vehicle is towed.

To the user view for the second step, add three fields as described in the following list.

1. A field that displays the service type as a read-only field.

2. A field group list that uses the services data type you created. Configure the property for the field
group list to copy data from the data page that lists the records for the data type.

3. A field that calculates the cost for all the services provided. The value should update whenever
inputs change. The calculation should execute regardless of the page containing the expression.

The third step in the process is now Resolve service.
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Change location optional action
For this stage, add an optional action that enables claimants to update the location information they
enter in the Notification stage.

The first step presents claimants with a form for updating the existing information. The next step
automatically updates the location information in the service case.

The source properties are in the Assistance Request class but the target properties are in the Service
class. Therefore, create the data transform in the context of the Service class.

Note: The name of the data transform is displayed in the Data Transform field but is not displayed
in the list of available rules.

Wrap-up stage
Gold membership requests are resolved when they enter this stage. However, Standard membership
requests must be invoiced before they are resolved. The stage includes a process for invoicing those
requests.

The first step in this process enables a representative to review the payment information claimants
enter in the payment information process. This view also contains a field that displays the invoiced
cost. This is calculated from the total cost calculated in the service case.

The second step automatically emails claimants a copy of the invoice with the information described in
the scenario.

Tip: You can reuse the section rule created for the user view that processes payment information in
the Notification stage.

Cancellation request process
Claimants can cancel a request at any point during the request life cycle. The claimants indicate
whether they want to cancel the request. Then, automated business logic decides how to handle the
request based on the choice the claimants make. If claimants cancel their request, the application
transfers the case to the Cancel Request alternate stage for resolution. The application confirms the
cancellation by sending an email to claimants. The email contains the message described in the
scenario.

Manager reports
Create the manager reports in the Assistance Request class as follows:

l Number and status of requests updated in past 30 days — Add columns for the fields described in
the requirement. Show the case status data as a count. Use a filter to include only cases updated in
last 30 days. Configure a column-type chart grouped by the entered-on data and a series of case ID
count.

l Services by membership type, service type, and service provider — Use the state field in the first
column. Add the columns in the sort order described in the report requirement. Summarize the
number of cases and calculate the average service cost.

l Average service cost per state — Use the state field in the first column. Summarize the number of
cases and calculate the average service cost. Use filters to determine the work status (resolved) and
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time frame (90 days). Use a map-type chart using state and average service cost as the columns.
Specify the Services by membership type, service type, and service provider as a drill-down report.

To enhance report performance, optimize the business properties used in filters and sorting. These
include state, service type, and service provider.

Test cases
Test your application using the steps in the following tables.

Case 1 — Notification stage processing
Step Do this: What happens:
1 Select any service type

and submit.
The enter customer information form is displayed.

2 Enter the information,
select the Standard
membership type, and
submit.

The location information form is displayed. The request has
a status of Pending-Qualification. The Customer work party
is displayed in the Participants section.

3 Enter the location
information and submit.

The vehicle information form is displayed.

4 Enter vehicle information
and submit.

The payment information form is displayed.

5 From the Action menu,
select the update
information option.

A form is displayed that contains all the fields for entering
customer, location, vehicle, and payment information.

6 Enter payment
information and submit.

The request is routed to a representative for approval.

7 Create another request,
select the Gold
membership type and
submit.

The request is routed to a representative for approval.

Case 2 — Setup stage processing
Step Do this: What happens:
1 Create a request, advance it

to the representative for
approval, and open the
request.

The approval form displays the customer, location, and
vehicle information in read-only format. Reject and
Approve buttons are displayed at the bottom of the form.
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Step Do this: What happens:
2 Reject the request. The request is resolved as rejected and the service not

covered notification is attached to the case.

3 Repeat step 1 and approve
the request.

The form for selecting the service provider is displayed.

Case 3 — Service and Wrap-up stage processing
Step Do this: What happens:
1 Create a Standard membership

request. Advance it to the
Select Provider form, select a
provider, and submit the form.

A Service child case is created and the Review service
details user form is displayed. It contains the service
type, customer, location, and vehicle information.

2 Submit the form. The Select services form is displayed. It contains a table
containing Service, Unit cost, Quantity, and Service cost
columns. The Service, Unit cost, Service cost fields are
read-only. The Quantity field is editable.

3 Enter a number in a Quantity
field and tab or click out of
field.

The total cost of the service is calculated and displayed
in the Total cost field.

4 Submit the form. The Resolve service form is displayed.

5 Indicate that the service is
complete and submit the form.

The service case user form shows that the case is
resolved.

6 From the form header, open
the parent assistance request
case.

The Assistance request form is displayed. The "Help is
on the way" notification is attached to the case.

7 Begin the Invoice (Wrap-up)
assignment.

The Review Service form is displayed, which contains
the service type, service provider, customer information,
and service cost in read-only format.

8 Submit the form. The case is resolved. The invoice is attached to the
case.

9 Open the attached invoice. The invoice contains the text message, the payment
information, and the total cost of services.
Note: In this exercise, the payment fields are editable.
In an actual implementation, a system architect would
configure the fields as read-only.

10 Create a Gold membership
request as described in step 1
and complete steps 2 through
5.

The assistance request case is resolved.
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Case 4 — Change location information
Step Do this: What happens:
1 Create a request and advance it to the Review service

details form in the Service case. Note the current location
information.

N/A

2 Open the parent assistance request case. The assistance request case
opens in a review form.

3 From the Actions menu, invoke the Update Location
action.

The Enter Location
Information user form
opens.

4 Update the information in any of the location fields and
submit the form.

The assistance request
review form opens.

5 Open the service child case and refresh it. Your updates are displayed
in the Review service details
form.

Case 5 — Cancel request processing
Step Do this: What happens:
1 Create a request and select the

Cancel Request option from the
Action menu.

The cancel request confirmation form is displayed.

2 Indicate that you want to cancel. The case is resolved. The cancellation notification is
attached to the case.

3 Open the correspondence. The message includes the case ID.

4 Create a request and select the
Cancel Request option from the
Action menu.

The cancel request confirmation form is displayed

5 Indicate that you want to cancel,
but click the Cancel button.

The Unsaved changes dialog is displayed, which
warns you that you are about to discard your
unsaved changes.

6 Click Discard. The Assistance Request case is displayed.

Case 6 — Manager reports
Create about 10 to 20 assistance request cases in various work statuses including New, Pending-
Qualification, Resolved-Completed, and Resolved-Rejected. Process these cases using various
membership types, service types, and locations.

From the Reports dashboard, open your reports.
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l Number and status of requests updated in past 30 days — A bar graph is displayed. Click a bar to
display the individual requests created that day.

l Services by membership type, service type, and service provider — A list of assignment request
cases is displayed. For each state, the report displays the membership type, service type, service
provider, count, and average service cost.

l Average service cost per state/region — A map that shows the average invoiced total for cases from
each state is displayed. Click an item on the map to view the related data in the Services by
membership type, service type, and service provider report.

Detailed steps
A proposed solution for this exercise is available as a download in the Related Content section.
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Course summary

System Architect Essentials summary
Now that you have completed this course, you should be able to:

l Explain the benefits of using the Pega model-driven application design and development approach

l Model the life cycle of a case that mirrors the way business people think about how work is
completed

l Identify the high-level responsibilities associated with Pega Platform for both Pega business
architects and system architects

l Describe Pega's Direct Capture of Objectives™ approach to increasing the speed and accuracy of
application delivery

l Explain the purpose and benefits of best practices and guardrails

l Validate case data to ensure that user entries match required patterns

l Configure a Wait shape to enforce a case processing dependency

l Configure user views and data elements during case life cycle creation

l Use the Clipboard tool to review case data in memory

l Set property values automatically using data transforms and declare expressions

l Configure and populate a work party with case data

l Create data classes and properties for use in a Pega application

l Automate decision-making to improve process efficiency

l Design responsive user forms for use on any platform or browser

l Design reports to deliver key insights to business users

l Incorporate and manage reference data to allow applications to adapt to changing business
conditions

l Test your application design to analyze rule behavior and identify configuration errors

Next steps
Completion of System Architect Essentials helps prepare students for the Certified System Architect
exam. To help you study for the exam, enroll in the CSA Practice Exam course in Pega Academy.
Register for the exam.

http://pearsonvue.com/pegasystems
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